
   
 

To students: 
 
Do you have problems with punctuation?  Would you like to write a résumé or research paper 
that helps you get a job or a scholarship or a good grade?  If so, then this handbook is for you.  
It is a guide for answers and a means of encouragement for you in your writing here at school.  
It is our hope for you to learn to think clearly and communicate easily.  It is our wish, in short, 
for you to write well.   
 

This handbook does not replace the requirements of your teachers; rather, we hope it 
enhances their advice and your ability to work with language at school and, we hope, in your 
future. 
 

 
 
To staff: 
 
This handbook is a product of our collaboration among the three high schools and the desire of 
the Communication Arts Departments to provide continuity and consistency in the writing 
expectations that we have for our students.  We have tried to make it user friendly and school 
specific.  We hope that you will refer to this handbook and incorporate it into your lessons as 
you guide your students through a variety of writing assignments this year. 
 
 
 
Handbook Collaboration Team 
 
Stacy Allison Special thanks to the 

following: 
• Christy Barger 
• LSNHS Handbook 

Team 

Mickey Dyer 
Christie Eulinger 
Merilee Grigsby 

• Janette Cooley 
• John Faulkenberry 
• Bonnie Knipmeyer 
• Robin Moeller 

Susan Hitman 
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Vickie Metzler 
 
 
 

If we had to say what writing is, we would define it essentially as an act of courage.  
 

--CYNTHIA OZICK 
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IINNTTRROODDUUCCTTIIOONN  
 
The six sections of your handbook contain basic skills, forms, documentation, and usage 
examples.  Because your teacher may have requirements beyond these, please use the Teacher 
Guidelines/Notes page below, and in various sections, to personalize your writing requirements. 
 
  Section 1:   Business English provides you with a sample résumé, a form to help you complete a 

rough draft of a personal résumé and a business letter and envelope format.  We recommend that 
you prepare a résumé to help you in college and scholarship applications.  Rather than assuming 
adults will support you, we strongly recommend writing a letter, similar to the one in the handbook, 
asking teachers, advisors, or other adults to be a reference.  Write a thank-you note to your 
references as a courtesy. 

 

  Section 2:   Research-Based Writing shows basic documentation skills and resources.  Please ask 
your teachers for specific documentation guidelines when you write research papers in different 
classes. 

 

  Section 3:   Computer Issues, shortcuts and hints with word processing, helps you to gain control 
while drafting, editing, and formatting.  

 

  Section 4:   Editing Your Writing, the biggest section, gives you a chance to edit those minor details 
in word choice, mechanics, and punctuation that make a major difference in the smooth reading and 
understanding of all of your writing. 

 

  Section 5:   The Glossary gives you three categories of definitions that you may need in language 
study:  grammar, sentence structure, and literary terms. 

 

  Section 6:   Language Resources is a list of sources we have consulted in creating this handbook. 
These are available in the LMC. 

 

 
 

 -2-
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SECTION 1: BUSINESS ENGLISH 
 

Judy Smith 
123 Tiger Blvd. 

Lee’s Summit, MO 22222 
(816) 524-2345  judysmith@yahoo.com 

 
 
OBJECTIVE  Acceptance to a Midwest liberal arts college with a superior program in 
 foreign languages   
 
 
EDUCATION Lee’s Summit High School (Graduating in May 20_ _ ) 
  400 SE Blue Parkway, Lee’s Summit, MO 64063 
 Honors courses in English and French 
 GPA 3.65/4.0   Class rank 61/585 
 
 
ACTIVITIES National Honor Society (12) 
 Yearbook staff (11) Editor (12) 
 DECA (10-11) 
 Swim team (9-11) 
  
  
HONORS & Foreign language contest, #1 rating in French conversation (11) 
AWARDS Principal’s Honor Roll (9-11) 
 Lettered in swimming (9-10) 
  
 
COMMUNITY Raised $100 in pledges for the March of Dimes (200_ ) 
SERVICE Tutored an elementary student in English, one hour per week (200_ ) 
 Trained volunteers for Vacation Bible School (199_ ) 
 
 
EXPERIENCE Time-Out Graphics, Lee’s Summit, MO (summer 200_  to present ) 

 Proofread and edited newsletters  
 Composed and designed promotional mailings 

 Hy-Vee, Lee’s Summit, MO (2004-2006) 
 Cashier 
 Stock 

 
REFERENCES Available upon request 
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  PPEERRSSOONNAALL  RRÉÉSSUUMMÉÉ  DDRRAAFFTT  
Use this space to update your résumé each year.  Writing in pencil may be a good idea. 

 
___________________________________ 
___________________________________ 
___________________________________ 
___________________________________ 

 
OBJECTIVE ________________________________________ 

 ________________________________________ 
 ________________________________________ 
 ________________________________________ 

  
 
EDUCATION ________________________________________ 

 ________________________________________ 
 ________________________________________ 
 ________________________________________ 

  
 
ACTIVITIES ________________________________________ 

 ________________________________________ 
 ________________________________________ 
 ________________________________________ 

 
 
HONORS & ________________________________________ 
AWARDS ________________________________________ 
 ________________________________________ 
 ________________________________________ 
 
 
COMMUNITY ________________________________________ 
SERVICE ________________________________________ 
 ________________________________________ 
 ______________________________________________ 
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*Bold & capitalize 
the heading of 
each category 

*Centered 
*Single-spaced 
*Bold type 

• Type your full name 
• Give a permanent 
address (i.e. parents) 

• List area code & phone 
number 

• Include e-mail address if 
you have one 

 
• Avoid listing a specific 
school to attend 

 
 
 
 

 
 
• List most recently 
attended school first 

• List subject matter of 
weighted courses, not 
specific courses 

• Include GPA if 3.0 or 
higher 

 
• Include most current 
activity first 

• School activities 
• Community activities 
• Church involvement 
• Hobbies 
 
 
• List most recent honors 
or awards first 

• Omit category if no 
honors or awards 

• List any community or 
church awards, too 

 

 
• List most recent service 
first 

• Include the year the 
service was performed 

*Text aligned 
*Single-spaced 
*No end mark 



EXPERIENCE ________________________________________ 
 ________________________________________ 
 ________________________________________ 

 ________________________________________ 
 
 
REFERENCES Available upon request 
 
 Names are not needed for this résumé  
 When needed, ask teachers, coaches, employers, neighbors, ministers—NOT relatives 
 Give to the person writing your letter of reference a résumé and a stamped, addressed 

envelope  (Write a thank-you note afterwards!) 
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• Again, list most recent 
job first 

• Include year(s) of 
employment 

• Briefly describe job 
responsibilities 

My notes or guidelines from my teacher… 
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_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_____________________________________________________________
_________________________________________________________ 



PPEE

123 Tiger Blvd. 
Lee’s Summit, MO 22222 
January 10, 200_ 
 
Mr. Prince E. Powell, Principal 
Lee’s Summit High School 
400 SE Blue Parkway 
Lee’s Summit, MO  64063 
 
Dear Mr. Powell: 
 
I am writing to ask if you would consider being a reference for me.  I am currently a junior at 
Lee’s Summit High School and applying for a summer job for the school district.  During the last 
two years, I have chosen a career in computers and taken business classes that have helped me 
learn about programming.  I think a job with the Lee’s Summit School District would help me 
prepare for a career working with computers after I graduate and also help me earn money for 
college.  I have been a dedicated student at LSHS and have made the honor roll twice. 
 
I am attaching a copy of my résumé to help you in your decision.  I will call you by the end of the 
week to ask if you would be willing to be a reference for me.  Thank you for your consideration. on. 
 
Sincerely, Sincerely, 
 
Joe Student Joe Student 
 
Joe Student Joe Student 
 

RRSSOONNAALL  BBUUSSIINNEESSSS  LLEETTTTEERR  FFOORRMMAATT  PP

 

 

 

 

EERRSSOONNAALL  BBUUSSIINNEESSSS  LLEETTTTEERR  FFOORRMMAATT  
 Sample reference request letter 
 Block Style, 2” top margin, 1” side margins 
 Single space with double spaces as indicated below 
 Quadruple space after Sincerely to leave room to sign your name 
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Set 2-inch top margin. 

 
 
 

Double 
space 

between 
each 

part of 
the 

letter. 

Press Enter four times to leave 
room for your signature. 

Set 1-inch  
side margins. 



AADDDDRREESSSSIINNGG  AANN  EENNVVEELLOOPPEE    
 

 
 
 
 
 
 
 
 
 
 
The sender’s return address should appear on the envelope, usually in the upper left-hand 
corner.  The addressee’s name should be placed a little below the center of the envelope.  
The ZIP code number follows the name of the state.  A comma separates the name of 
the city and state.  The state is a two-letter postal code abbreviation.   
 

SSTTAATTEESS  AANNDD  PPOOSSTTAALL  AABBBBRREEVVIIAATTIIOONNSS                            
 
Alabama AL Kentucky  KY Oklahoma  OK  
Alaska AK Louisiana  LA Oregon  OR  
Arizona AZ Maine   ME Pennsylvania  PA  
Arkansas AR Maryland  MD Puerto Rico  PR  
California CA Massachusetts  MA Rhode Island  RI  
Colorado CO Michigan  MI South Carolina SC  
Connecticut CT Minnesota   MN South Dakota  SD  
Delaware DE Mississippi  MS Tennessee  TN  
District of  Missouri  MO Texas   TX  
Columbia DC Montana  MT Utah   UT  
Florida FL Nebraska  NE Vermont  VT  
Georgia GA Nevada  NV Virginia  VA  
Guam  GU New Hampshire      NH Virgin Islands  VI  
Hawaii HI New Jersey  NJ Washington  WA  
Idaho  ID New Mexico  NM West Virginia   WV  
Illinois IL New York   NY Wisconsin  WI  
Indiana ID North Carolina   NC Wyoming  WY  
Iowa  IA North Dakota   ND   
Kansas KS Ohio   OH  
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Miss Lorna Dobbs 
79 West 111 Street 
New York, NY 10026 
 

Dr. Theodora Van Lunt 
       34 East Forty-first Street 
       Rochester, NY 14627 



  
  

Writing is an exploration. You start from nothing and learn as you go. 
 

--E. L. DOCTOROW 

WWHHYY  DDOOCCUUMMEENNTT??  
 

Proper documentation is a very detailed process; therefore, you will find references on 
documentation to be your constant companions in making good grades on research 
papers.  If you write papers in English and history classes, you will find two common 
kinds of documentation styles, MLA and APA.  While their formats differ slightly, 
their purposes are still the same.   
 
The purposes of all documentation are the following:  

• to let your reader know that you know what you are talking about (this is establishing 
authority), 

• to give credit to others’ ideas and words not your own (this is avoiding plagiarism), 
and  

• to help your reader find the information you have researched (this is being courteous 
as well as correct). 

 
Documentation, thus, is important for both the writer and the reader.  
 
We have outlined the basics of documentation in this handbook, but the best resource 
for your documentation needs is your teacher.  It is your responsibility to ask your 
teacher for guidelines and to pay careful attention to the instructions and 
documentation details.  You will find more detailed information from your library media 
specialists and online.   
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SECTION 2: RESEARCH-BASED WRITING 



  AAPPAA  ((AAMMEERRIICCAANN  PPSSYYCCHHOOLLOOGGIICCAALL  AASSSSOOCCIIAATTIIOONN))  
 

APA documentation is the format developed and first published by the American Psychological 
Association in 1929 to help writers submitting journal manuscripts.  APA style is most often 
used in history and science classes.  This style calls for internal documentation, called 
citations, and a References page at the end of the paper for every citation.   
 

APA style values when a source was written and uses commas in citations between name and 
date.  Thus, an APA citation always includes the name and date of the document (instead of a 
page number) and separates them with a comma.   
 

For example, the same citation about Baron, using direct quotations, would look like this for APA: 
 

In the words of a famous linguist, “the alphabet may be the biggest 
problem we have with English” (Baron, 1989).   

 

Please note the following details: 
• Commas are used in APA internal documentations. 
• Dates are used instead of page numbers. 
• There is no period before the internal documentation.  The period is after the parentheses. 

 

If you wish to summarize Baron’s words without a direct quotation and use his name in the sentence, it 
would look like the following for APA: 

Dennis Baron, a famous linguist, also discusses the difficulties of the 
alphabet for English speakers (1989). 

 

You must cite an author’s words and/or ideas.   The citation needs to be recorded as a full 
bibliography on a References page, the very last page of your paper.  A bibliography contains 
publishing information such as the author’s or editor’s name, date of publication, full title, 
place published, and publishing company.  Below is an example of an APA References page. 
 

Please note the following details: 
• APA References pages do not capitalize the first letter of words in the title. 
• Sources are arranged in alphabetical order, and each author’s first name is indicated only by 

an initial. 
• Periods are used to separate items of information and to end the citation. 
 

 
                                                                                                                Smith 7 

References 

   Baron, D.  (1989). Declining grammar and other essays on the English 

language.  USA:  NCTE. 

   Lee, H.  (1960). To kill a mockingbird.  NY:  Warner Books. 
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MMLLAA  ((MMOODDEERRNN  LLAANNGGUUAAGGEE  AASSSSOOCCIIAATTIIOONN))  
 

MLA documentation refers to the format established by the Modern Language Association.    
It is the style most often used in English classes.  MLA style calls for parenthetical or internal 
documentation and a Works Cited page at the end of the paper. 
 
For example, if you wish to cite Dennis Baron in a paper about language, internal documentation of a 
direct quotation from page 15 of his book would look like this:   
 

In the words of a famous linguist, “the alphabet may be the biggest 
problem we have with English” (Baron 15).   

 

Please note the following details: 
• There is no punctuation, i.e. comma, in the internal documentation. 
• There is no abbreviation, i.e. pg. or pps., to indicate page numbers. 
• There is no period before the internal documentation.  The period is after the parentheses. 

 

If you wish to summarize Baron’s words without a direct quotation and use his name in the sentence, 
however, it would look like this: 
 

Baron, a famous linguist, also discusses the difficulties of the alphabet 
for English speakers (15). 

 

In both cases, because you have cited someone else’s words or ideas in your paper, you must 
also cite the source of that information.  Where, you ask?  A citation needs to be recorded as 
a full bibliography on a Works Cited page, which is the very last page of your paper.  A 
bibliography contains publishing information such as the author’s or editor’s name, full title of 
the work, place published, publishing company, and date of publication.  Below is an example.   
 

Please note the following details: 
• Sources are arranged in alphabetical order by authors’ last names. 
• Periods are used to separate name and title and to end the citation. 
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Works Cited 

   Baron, Dennis.  Declining Grammar and Other Essays on the English 

Language.  USA:  NCTE, 1989.  Print. 

   Lee, Harper.  To Kill a Mockingbird.  NY:  Warner Books, 1960.  Print. 
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RREESSOOUURRCCEE  CCIITTAATTIIOONN  FFOORRMMAATTSS  
 
 
 

Service Names for Online Databases 
EBSCO 
 Academic Research Premiere / Alt-Health Watch  / Clinical Pharmacology / EBSCO Animals / Communication and Mass Media / Funk and Wagnall’s 

/ Health Source: Consumer Edition / Health Source: Nursing/Academic Edition 
 
Gale Group 
 Biography Resource Center / LitFINDER / Opposing Viewpoints / Student Resource Center 
 
ProQuest 
 Culture Grams / eLibrary / Government Reporter / NY Times Historic Newspapers 
 
Oxford University Press 
 Oxford Reference 
 
World Book 
 World Book Online Reference Center 
 

Online Database 
NEWSPAPER or MAGAZINE ARTICLE 

• Author 
• Article Title 
• Newspaper/Magazine Name 
• Date article originally published 
• Edition 
• Section Page No(s)/Page Numbers 
• Name of Database 
• Service Name 
• Location Accessed From 
• City Accessed From 
• Date Accessed 
Margolies, Dan. "Residential Proposal near Plaza Takes Shape." The Kansas City Star 7 May 2002: A1. NewsBank. 

EBSCO. Lee's Summit High School, Lee's Summit, MO.  Web.  9 May 2002.  
McKinley, Jesse.  “Bio What?  A Diversity of Opinion.”  New York Times 5 June 1998:  7 pars.  Electric Library.  Lee’s 

Summit High School Library Media Center, Lee’s Summit, MO.  Web.  7 July 2005. 

Online Database 
PROFESSIONAL JOURNAL 

• Author 
• Article title 
• Journal name 
• VolumeNumber.IssueNumber 
• Year journal published 
• Page numbers (if given) 
• Name of database 
• Service name 
• Location accessed from 
• City accessed from 
• Date accessed 
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McMillin, Bradley. “A Statewide-Evaluation of Academic Achievement in Year-Round Schools.” Journal of Educational 
Research  95.2 (2001): 67-75. Academic Search Premier. EBSCO. Lee's Summit High School Library Media Center, 
Lee's Summit, MO. Web.  30 Oct. 2003. 



Online Database 
BOOKS 

• Author 
• Article title 
• Book title 
• Date Book was published 
• Online database name 
• Service name 
• Location accessed from 
• City accessed from 
• Date accessed 
• Found via 

(Narrative Biography Example) 

“Hernando De Soto.” Dictionary of American Biography 2002.  Biography Resource Center. Gale Group. 
Lee’s Summit High School, Lee’s Summit, MO.  Web.  11 Nov. 2002. 

(Book Example) 
Abbott, John C. “De Soto Discovers the Mississippi.” History of the World 1992.  Electric Library. ProQuest. 

Lee’s Summit High School, Lee’s Summit, MO. Web.  11 Nov. 2002. 

(Viewpoint Essay Example) 

Dority, Barbara. “Arguments Against Legalizing Physician-Assisted Suicide are Unconvincing.” 
Assisted Suicide 1998. Opposing Viewpoints. Gale Group. Lee’s Summit High School, Lee’s 
Summit, MO. Web.  6 Oct. 2004. 

FREE WEB ENCYCLOPEDIA ARTICLE 
[no subscription required] 

• Author 
• Article title 
• Name of encyclopedia 
• Year encyclopedia published 
• Date accessed 
• URL  
Pinder, D. A. “Canterbury.” World Book Online Americas Edition. 2003. Web.  9 May 2002 . 
 

FREE WEB SITE  
[no subscription required] 

• Author 
• Title of the document 
• Web site title 
• Date created 
• Institution associated with 
• Date accessed 
• URL  
Quinn, Dennis. “Commodus (A.D. 180-192).” De Imperatoribus Romanis. 4 Jan. 1999. DRI Collegium 

Editorum. Web.  6 Oct. 2004. 
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FREE WEB NEWSPAPER or MAGAZINE  
[no subscription required] 

• Author 
• Article title 
• Magazine/newspaper name 
• Date article published 
• Date accessed 
• URL  
[Newspaper] Margolies, Dan. “Residential Proposal near Plaza Takes Shape.” The Kansas City Star 7 May 

    2002: A1. Web.  09 May 2002. 
[Magazine] Eisenberg, Daniel. “Paying to Keep Your Job.” Time. Web.  9 May 2002. 
 

FREE WEB PROFESSIONAL JOURNAL  
[no subscription required] 

• Author(s) 
• Article title 
• Journal name 
• VolumeNumber.IssueNumber 
• Year published 
• Page numbers (if given) 
• Date accessed 
• URL 
Ray, Beverly. “PDAs in the Classroom: Integration Strategies for K-12 Educators.” International Journal of 

Educational Technology 3.1 (2002): 5-12. Web.  30 Oct. 2003.  
 
 

E-MAIL MAILING LIST 
• Author 
• Subject of post 
• Words: Online Posting 
• Date posted 
• Name of newsgroup 
• Date accessed 
• URL of newsgroup 
Royce, John. “Plagiarism Dilemma.” Online posting. 30 May 2002. LM_NET. 7 Oct. 2002.  
 

E-MAIL, PERSONAL 
• From 
• E -Mail subject 
• E-mail to FirstName LastName. 
• Date read 
Affleck, Ben. “Your Latest Movie.” E-mail to Jennifer Garner. 03 Jan. 2006.  
 

PRINT: BOOK 
• Author 
• Title 
• Place:publisher 
• Date published 
Worley, William S. Beal Street: Crossroads of America's Music. Lenexa, KS: Addax Group, 1997. 
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Print.



 

 

PRINT:  
ENCYCLOPEDIA ARTICLE 

• Author 
• Article title 
• Name of encyclopedia 
• Total number of volumes 
• Place:publisher  
• Date published 
Urry, William. "Canterbury." Encyclopedia Americana. 30 vols. Danbury: Grolier, 2000.  Print. 
 

PRINT:  
NEWSPAPER or MAGAZINE ARTICLE 

• Author 
• Article title 
• Newspaper/magazine Name 
• Date published 
• Edition [newspaper only] 
• Page(s) 

[Newspaper] Margolies, Dan. "Residential Proposal near Plaza Takes Shape." The Kansas City Star 
       7 May 2002: A1-A4.  Print. 

[Magazine] Eisenberg, Daniel. "Paying to Keep Your Job." Time 15 Oct. 2001: 80-83.  Print. 
 

INTERVIEW (BY YOU) 
• Person interviewed 
• Type interview 
• Date interviewed 

Faulkenberry, John. Personal interview. 1 Apr. 2002.   

VIDEO – DVD or VHS 
• Title 
• Director 
• Main performers 
• Type 
• Distributor 
• Year release 
• [DVD] Arsenic and Old Lace. Dir. Frank Capra. Perf. Cary Grant. DVD. Turner Entertainment,      

  1944.  DVD. 
• [VHS] Arsenic and Old Lace. Dir. Frank Capra. Perf. Cary Grant. Videocassette. MGM/UA  

  Home Video, 1944.  VHS. 

 
GENERAL MLA  

FORMATTING RULES 
 CAPITALIZATION – First words, last words, and all principal words 
 MISSING INFORMATION – Supply as much information as you can. If something is 

missing, go onto the next element in the citation. 
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 TITLES-MLA recommends italicizing titles; no more underlining. 



 

SSAAMMPPLLEE  MMLLAA  WWOORRKKSS  CCIITTEEDD  PPAAGGEE  
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PPLLAAGGUUEEDD  BBYY  PPLLAAGGIIAARRIISSMM??  
 

Plagiarism is a kind of cheating.  It is taking someone else’s words or ideas and claiming that 
they are your own.  Thus, you cheat someone out of the recognition he should rightfully have, 
and you cheat personally by posing as someone you are not.   
 

Intentional plagiarism, copying someone’s words into your own paper without quotation marks, 
or cutting and pasting into your paper from an Internet source without documentation, is 
serious cheating.  Schools have serious consequences for this offense.  We do, too.   
Administrators handle some penalties as explained in your student planner, and individual 
teachers handle the penalty for cheating in their classes.  These penalties could range from a 
zero on the assignment to school suspension.   
 

Sometimes plagiarism is unintentional—you didn’t use quotation marks around some words 
because you didn’t know you had to in a summary or paraphrase.  Well, now you know.  You have 
to document the source if you use someone else’s words or ideas.  A good example of 
unintentional plagiarism comes from a UMKC Student Handbook.  Its example, illustrating a 
passage from Strunk and White’s Elements of Style, shows how easy it is to unintentionally 
plagiarize.  The original passage reads like this: 
 

A sentence should contain no unnecessary words, a paragraph no 
unnecessary sentences, for the same reason that a drawing should have 
no unnecessary lines and a machine no unnecessary parts.  This 
requires not that the writer make all his sentences short or that he avoid 
all detail . . . but that every word tell. 

 

In writing a paraphrase of this passage, shown below, a student uses words and sentence 
structures from the original passage and ends up plagiarizing unintentionally.  Compare the 
italicized words with the original above. 
 

Writing should not have unnecessary words or sentences for the same 
reasons machines have no extra parts.  This does not mean that the 
author only writes brief sentences, but that he makes every word count. 

 

The version below represents a successful summary, instead of a paraphrase, because it 
doesn’t repeat key words or imitate the sentence structure of the original.  In writing a 
summary, you express briefly an author’s idea in your own words and own sentence structures 
and, thus, avoid the problem of plagiarism. 
 

Strunk and White describe good writing in both mechanical and artistic 
analogies.  They explain that good writing is economical, clear, and 
accurate. 

 

Your teacher and your textbooks can provide you with more instructions and practice in writing 
a summary to cure yourself of the plague of unintentional plagiarism.    
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SECTION 3:   COMPUTER ISSUES 
  
SSHHOORRTTCCUUTTSS  
 

 Ctrl + N New Document 

 Ctrl + O Open Existing Document 

 Ctrl + S Save Current Document 

 Ctrl + P Print Current Document 

 --- Print Preview 

 F7 Spell Check 

 Ctrl + X Cut (whatever is highlighted) 

 Ctrl + C Copy (whatever is highlighted) 

 Ctrl + V Paste (whatever was last cut/copied) 

 Ctrl + Z Undo the Preceding Action  (can undo multiple preceding 
actions) 

 Ctrl + Y Redo Preceding Undone Action (can redo multiple actions) 

 Ctrl + * Show All (spaces, returns, etc.) 

 Ctrl + B Boldface 

 Ctrl + I Italicize 

 Ctrl + U Underline 

 Ctrl + L Left Justified 

  Ctrl + E Centered 

 Ctrl + R Right Justified 

 Ctrl + J Justified 

 --- Numbering (add or remove) 

 --- Bullets (add or remove) 

--- Ctrl + 1 Single Spacing 

--- Ctrl + 5 1.5 Line Spacing 

--- Ctrl + 2 Double Spacing 

--- Ctrl + A Highlight All Text 

--- Ctrl + Shift + D Double Underline Text 

--- Ctrl + Shift + W Underline Words but not Spaces 
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WWOORRDD  PPRROOCCEESSSSIINNGG  FFEEAATTUURREESS  

Change Page Setup 

1. Under the File menu, click Page Setup. 
2. In the Page Setup dialog box, click tabs to change the margins, paper size, paper source, and 

layout.  

Set Margins  

1. Under the File menu, click Page Setup.  
2. In the Page Setup dialog box, click on the up and down arrows to set the margins.  

Select Line Spacing  

1. Highlight the paragraphs you wish to change to a new line spacing.  
2. For single-spacing, hold down the Control key and press the number 1 key.  
3. For 1½ line spacing, hold down the Control key and press the number 5 key.  
4. For double-spacing, hold down the Control key and press the number 2 key. 

Align Text  

1. Highlight the desired text.  
2. Select an alignment button from the Formatting Toolbar (Align left      , Align center      , Align 

right      , or Justify      .  
3. The text you selected will appear in the new alignment.  

Move Text  

1. Highlight the desired text. 
2. Click the mouse on the Cut       button on the Standard Toolbar.  
3. Click the mouse at the new location for the text.  
4. Click the mouse on the Paste       button on the Standard Toolbar.  

Copy Text  

1. Highlight the desired text.  
2. Click the mouse on the Copy       button on the Standard Toolbar. 
3. Click the mouse at the new location for the text.  
4. Click the mouse on the Paste       button on the Standard Toolbar. 
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Find Text 

1. Under the Edit menu, click Find.  
2. Type the word you wish to find in the dialog box.  
3. Click Find Next in the dialog box.  
4. Word highlights the first match, click Find Next to find the next time the word appears.  

Replace Text  

1. Under the Edit menu, click Replace.  
2. In the dialog box, type the word you wish to find and the replacement word.  

Count Words in a Document  

1. Under the Tools menu, click Word Count. 
2. A dialog box appears that displays information about the document.  

Change Appearance of Text  

1. Highlight the desired text.  
2. Under the Format menu, click Font.  
3. In the Font dialog box, click the Font tab and select a design for your highlighted text and 

click.  You can change the font, font style, size, color, and effects.  

Change Font Style or Size  

1. Highlight the desired text.  
2. Click the down arrow beside the words: Times New Roman                          on the Formatting 

Toolbar and select the desired font style.  
3. Click the down arrow beside the number 12          on the Formatting Toolbar and select the 

desired font size.  

Change Font Color  

1. Highlight the desired text.  
2. On the right end of the Formatting Toolbar, click the down arrow beside the letter     and 

select the desired font color.  

Use Highlighter  

1. Highlight the desired text.  
2. At the right end of the Formatting Toolbar, click the down arrow beside the Highlight pen.  
3. Select the desired highlight color.  
4. The desired text will appear highlighted in the color you selected.  
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Insert Symbols  

1. Click the mouse where you want the symbol inserted into your document.  
2. Under the Insert menu, click Symbol.  
3. Click the symbol you wish to insert and then click Insert.  
4. Click Close.  

Add Bullets or Numbers  

1. Highlight the text you wish to have bulleted or numbered.  
2. Click Format. 
3. Click Bullets and Numbering. 
4. In the Bullets and Numbering dialog box, click the type of list you want to create.  
5. Click the style you desire.  
6. Click OK.  

Adding a Tab  

1. Highlight the text where a tab is needed.   
2. Under the Format menu, click on Tabs. 
3. Type in the location on the ruler where you would like the tab to appear and format the tab as 

you want it.  
4. Click the Select button.  Continue to add any additional tabs by clicking the Select button after 

each one. 
5. Click Close.  

Adding Headers and Footers  

1. Display your document in the Page Layout view by clicking Page Layout or Print Layout under 
the View menu.  

2. Under the View menu, click Header and Footer.  
3. Type the header in the text box and format as you would any other text.  
4. To create a footer, click the Switch Between Header and Footer button in the Header and 

Footer toolbar.  

Insert a Page Break  

1. Click the mouse where you want to start a new page.  
2. Under the Insert menu, click Break.  
3. In the Break dialog box, select Page Break.  
4. Click OK. 
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Center Text Vertically on a Page  

1. Highlight the text you want centered.  
2. Under the File menu, click Page Setup.  
3. In the Page Setup dialog box, click the Layout tab and select Vertical Text Alignment.  
4. Click OK.  

SECTION 4:  EDITING YOUR WRITING 
 

TTHHEE  WWRRIITTIINNGG  PPRROOCCEESSSS                                  
 

1. PREWRITE AND EXPLORE – Prewriting is a stage of exploring what you 
already know and discovering what you need to find out.  Freewriting, talking 
to friends, reading, or drawing pictures are examples of how to explore ideas. 

 
2. DRAFT AND DISCOVER – Drafting is a stage of discovery where you put 

your thoughts on paper.  Emphasis should be on ideas, not on perfecting every 
detail. 

 
3. REVISE YOUR WRITING – Revising is a stage of thought and change.  

Revising falls into two categories:  revising for ideas and revising for form. 
 

4. PROOFREAD – Proofreading is a stage of correcting the conventions.  This 
includes capitalization, spelling, punctuation, and getting your paper ready for 
the reader. 

 
5. PUBLISH AND PRESENT – Publishing and presenting is the stage of sharing 

your finished paper with a larger audience.  This is accomplished by oral 
presentation, displaying your paper, or submitting it for publication. 

 
6. REFLECT ON YOUR WRITING – Reflecting is the stage of taking time to 

think about your writing process.  Reflections can take the form of a journal 
entry or a note to your teacher or fellow writers. (Should be attached to the 
writing and added to your portfolio) 
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WWRRIITTIINNGG  OORRGGAANNIIZZAATTIIOONN                                        
 

1.   THESIS STATEMENT – A statement of the purpose, intent, or main idea of an 
       essay.  This must be a declarative sentence. 

 
2. POINT OF VIEW – A position or angle from which the story is written.  Consider the 

following: 
• For an informal paper, use first person singular. 
• For a more formal paper, use third person singular. 
• Avoid the second person YOU in formal compositions. 
• Always maintain a consistent point of view. 

 
3.  INTRODUCTION – The opening paragraph must: 

• Gain the attention of the reader. 
• State the topic of the essay (thesis statement). 
• State the author and title if literature is the subject. 
• State any relevant background information. 
• Allow for a smooth transition into the body of the writing. 

 
4.  CONCLUSION – The concluding paragraph should: 

• Briefly restate the thesis. 
• Summarize major points. 
• Tie any loose ends left in the body of the paper. 
• Leave the reader with a clear understanding of the meaning and significance of the 

essay. 
 

5.  TITLES – The title should follow these guidelines: 
• Be original but not cute or trite. 
• Reflect your thesis. 
• Capitalize the first word, the last word, and all principal words in a title. 
• Do not capitalize a, an, the, prepositions, or coordinating conjunctions 

(and, but, or, for, nor, so, and yet). 
 

6.   PREPARING FOR THE FINAL DRAFT – Did you: 
• Follow all the rules and guidelines given to you regarding your first draft? 
• Place essential information (name, subject, date, teacher’s name, etc.)? 
• Proofread the final draft against the edited version of your writing? 
• Meet your deadline? 
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          Your Last Name 1 
 

Your first and last name 
 
Teacher 
 
Class 
 
Date 
 

The Title of Your Paper 
 

You must use MLA format for your papers.  The text should be typewritten, using a size  
 
twelve (12) font.  Type on one side of the paper only.  Use a standard, easily readable typeface.   
 
Your entire paper must be double-spaced, including the direct quotations; do not quadruple space  
 
between paragraphs.  Indent the first word of each paragraph five spaces.  All margins are one  
 
inch—at the top and bottom and the left and right sides of the text. 
 

Do not use a title page.  Instead, type a heading in the upper left-hand corner, one inch from  
 
the top of your paper (a double-space after your last name and the page number, aligned left).   
 
Look at the example above.  Page numbers should be typed in the upper right-hand corner, one- 
 
half inch from the top of the paper, aligned right.  Type your last name before the number of the  
 
page as shown above.  Double-space after the heading and center the title.  Do not underline the  
 
title or put the title in quotation marks or type the title in all capital letters; review capitalization  
 
rules to determine which words to capitalize in your title.  Double-space once again to begin  
 
your paper. 
 

Please do not use any special folders or covers.  Proofread your paper one more time, and  
 
staple neatly in the upper left-hand corner. 
 
RECOMMENDATION:  MLA Handbook for Writers of Research Papers by Joseph Gibaldi 
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66  ++  11  TTRRAAIITT  WWRRIITTIINNGG  ––  WWRRIITTIINNGG  FFOORR  AANNYY  OOCCCCAASSIIOONN                                      

 
 

Ideas and Development             Organization           

Clarity        An inviting introduction 
Focused and relevant     Thoughtful transitions 
Details that matter      Logical sequencing 
Fresh and original      Pacing is under control 
        A satisfying conclusion  
         

Voice               Word Choice _______ 

Individual and engaging     Lively verbs 
“aches with caring”                         Original and deliberate choices 
Honest, committed, responsive           Special Moments  
Suits audience and topic      Visual 
Strong interaction with reader    Specific and precise 
            
Sentence Fluency              

Rhythm, flow, and natural cadence 
Smooth phrasing 
Well-built sentences 
Sentence length enhances the meaning 
Varied sentence beginning         
 
Conventions ________      

Spelling, capitalization, punctuation, grammar/usage, and paragraphing (indenting) 
Ready for a public audience 
Control brings out style and enhances the ideas 
Shows more than just “the basics”        
 
Presentation  _______ 

Black/blue ink only (black only when typed) 
Proper heading  
Proper title 
Correct margins 
Correct font (usually 12 pt Times New Roman)      
 
Total          ______/ 
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TToooo  DDeeppeennddeenntt  UUppoonn  SSppeellll  CChheecckk?? 
You learn to spell from reading and writing experiences as well as from the feel of writing as the hand 
moves across the page.  Often, as you edit, you even know if a word looks right or not.  In some cases, 
using the dictionary is the best answer for spelling.  Besides using the dictionary, applying the computer 
spell checker and knowing some basic spelling rules can help you become responsible for your own 
writing.  Ultimately, you will find no tricks to good spelling.  Your experiences in writing will tell you that 
practice and care about what you want to say are the best ways to improve your spelling. 
 

7 common spelling rules  
Use i before e except after c or when sounded like ay, as in neighbor and weigh. 
 

i before e   relieve, believe, sieve, niece, fierce, frieze 
e before i   receive, deceive, sleigh, freight, eight 
EXCEPTIONS  seize, either, weird, height, foreign, leisure 

Drop a final silent e when adding a suffix that begins with a vowel.  Keep the final e if the suffix begins 
with a consonant. 

 

desire, desiring  achieve, achievement 
remove, removable  care, careful 
EXCEPTIONS  changeable, judgment, argument, truly 

When adding the suffix –s or –ed to words ending in y, ordinarily change y to i when the y is preceded by 
a consonant but not when it is preceded by a vowel. 

comedy, comedies  monkey, monkeys 
dry, dried   play, played 

 

If a final consonant is preceded by a single vowel and the consonant ends a one-syllable word or a 
stressed syllable, double the consonant when adding a suffix beginning with a vowel. 

bet, betting  
commit, committed  
occur, occurrence 

 

Add –s to form the plural of most nouns; add –es to singular nouns ending in s, sh, ch, and x. 
table, tables   church, churches 
paper, papers  dish, dishes 

 

Add –s to nouns ending in o when the o is preceded by a vowel.  Add –es when it is preceded by a 
consonant. 

radio, radios  hero, heroes 
video, videos  tomato, tomatoes 
EXCEPTIONS  pianos, solos, memos 

 

Form the plural of English words derived from other languages such as Latin or French just as you would 
in their original language. 

criterion, criteria 
datum, data 
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medium, media  



 

110000  CCOOMMMMOONNLLYY  MMIISSSSPPEELLLLEEDD  WWOORRDDSS  
 

absence 
academic 
accidentally 
accommodate 
acknowledge 
acquaintance 
acquire 
across 
address 
all right 
altogether 
amateur 
analyze 
answer 
apparently 
appearance 
appropriate 
argument 
arrangement 
ascend 
athlete 
athletics 
attendance 
audience 
basically 
beginning 
believe 
benefited 
bureau 
business 
calendar 
candidate 
cemetery 
changeable 
characteristic 
column 
commitment 
committed 
committee 
competitive 

conceivable 
conferred 
conscience 
conscious 
courteous 
criticism 
curiosity 
dealt 
decision 
definitely 
describe 
description 
desperate 
develop 
disappear 
disappoint 
disastrous 
dissatisfied 
eighth 
eligible 
embarrass 
eminent 
emphasize 
entirely 
environment 
especially 
exaggerated 
exhaust 
existence 
familiar 
fascinate 
February 
foreign 
forty 
fourth 
government 
grammar 
guidance 
harass 
height 

illiterate 
incidentally 
incredible 
indispensable 
inevitable 
intelligence 
interesting 
irrelevant 
irresistible 
knowledge 
laboratory 
license 
loneliness 
maintenance 
maneuver 
mathematics 
mischievous 
necessary 
noticeable 
occasionally 
occurred 
occurrence 
omitted 
optimistic 
pamphlet 
parallel 
particularly 
pastime 
perseverance 
perspiration 
phenomenon 
physically 
playwright 
politics 
practically 
precede 
precedence 
preference 
preferred 
prejudice 

privilege 
proceed 
professor 
pronunciation 
quiet 
quite 
quizzes 
receive 
recommend 
reference 
referred 
repetition 
restaurant 
rhythm 
ridiculous 
roommate 
sandwich 
schedule 
secretary 
seize 
separate 
sergeant 
similar 
sincerely 
sophomore 
subtly 
succeed 
surprise 
thorough 
tragedy 
transferred 
truly 
unnecessary 
usually 
vacuum 
vengeance 
villain 
weird 
whether 
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writing 



 

I misuse this a lot! 
 

Alot (spelled as one word) 
is not a word.  Unfortunately, 
a lot is misspelled a lot.   

OONNEE  WWOORRDD  OORR  TTWWOO??  
Already or All ready 
Already is an adverb meaning “even now” or “previously.”  All ready is an adjective phrase meaning 
“completely prepared.” 

We are already late. 
We are all ready for the tournament. 
 

Altogether or All together 
Altogether means “entirely” or “on the whole.”  All together means that all parts of a group are 
considered together. 

This news story is altogether false.   
A team pulling all together wins a tug of war. 
 

Awhile or A while 
Awhile is an adverb meaning “a short time.”  A while is used after a preposition. 

I'll be back in a while. Can you wait awhile?  
Everyone or Every one 
Everyone means “every single person.”  Every one is usually followed by the word of and means “each 
one.” 

Everyone sang along.  
Every one of the students sang along. 
 

Maybe or May be 
Maybe is an adverb meaning “possibly.” May be is a verb phrase.   
 Maybe I’ll get out of class early. 
 We may be let out of class early. 

DDOO  YYOOUU  WWRRIITTEE  IITT  RRIIGGHHTT??  
A lot or Allot or Alot 
A lot means “a great deal”; there is no such word as alot ; 
and allot means to “set aside.” 

We need a lot of money.  
Therefore, Dad will allot funds according to need. 

 

Accept or Except 
Accept is a verb that means “to receive” or “to agree to.”  Except is a 
preposition that means “but” or “excluding.” 

I would accept your excuse, except the part about losing the watch. 
I have considered every option except that one. 
 

Affect or Effect 
Affect is a verb that means “to influence.”  Effect can be either a noun or a verb.  The noun effect 
means “the result of an action.”  The verb effect means “to cause” or “to bring about.” 

Ingesting alcohol affects her driving competence. 
What effect does this have on you?  How does it affect you? 
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Strong leaders are able to effect change.  



 

All right!  I get it. All right or Alright 
 

Alright should never be used. 
The only word that is all right 
to use is all right, all right?   

All right used to reply to a question means “yes” or “well 
then.” 
As an adjective, all right means “satisfactory” or “feeling 
okay.”   
All right used as an adverb means “satisfactorily.”  
 There is no such word as alright ; forget about it, all right? 
 

Allusion or Illusion 
Allusion is a reference to something literary or historical with which the reader is presumably familiar.  
An illusion is a false, misleading, or overly optimistic idea. 

In preparing for his most spectacular illusion, the magician made an allusion to the magic of 
Houdini. 

 

Almost or Most 
Almost means “approximately” or “nearly.”  Most means “the majority” or “mainly.” 
 Almost all of the students spend most of their lunchtime talking rather than eating. 
 

Among or Between 
Among refers to a group of more than two people or things.  Between refers to two people or things. 

We quarreled among the five of us, but the real argument was between Bob and Harold.  
 

Amount or Number 
Amount refers to how much (items that cannot be counted).  Number refers to how many (this can be 
counted). 

A large number of students were absent from school today because a large amount of snow fell 
during the night. 

 

Angel or Angle 
An angel is a heavenly being.  An angle is a perspective or a slant. 
 In Charlie’s Angels, the television series, the voice of Charlie belongs to John Forsythe. 
  From this angle, I can see almost the entire city. 
 

Are or Our 
Are is a verb.  Our is a possessive pronoun. 
 The guests are here. 
 We are welcoming them into our home. 
 

As or Like 
As, as if, and as though should be used to introduce a subordinate clause.  Like is either a verb or a 
preposition.  It does not introduce a subordinate clause.   

It looks as if it is going to rain.  (NOT—It looks like it is going to rain.) 
She is tall like her mother. 
Mrs. Hile likes chocolate ice cream more than any other flavor. 

 

Assure or Ensure or Insure 
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Assure means “to convince” or “to guarantee.”  Assure takes a direct object—usually a person or group 
of persons. You assure someone that something has been done. Ensure means “to make certain.”  Ensure 



 

does not imply that you are giving assurance to someone else. You ensure that something has been done.  
Insure means “to guard against loss.”   

 

I assure you of my good intentions.  
Ensure that you lock your car.  
Please   insure this package.  

 
Bad or Badly 
Use bad as an adjective and as a predicate adjective after linking verbs.  Use badly, an adverb, to 
modify an action verb. 

 

I feel bad about the mess I made.  (NOT—I feel badly about the mess I made.) 
The room smelled bad. 
Mom felt bad about my brother’s behaving badly during my dance recital. 

 

Beside or Besides 
Beside means “at the side of ” or “next to.”  Besides means “except” or “in addition to.”  

 

Besides my aunt and uncle, there were fourteen other people standing beside the car. 
 

Between (see Among) 
 

Bring or Take 
Bring refers to a movement toward or with the speaker.  Take refers to a movement away from the 
speaker or the subject of the sentence. 

 

 Will you bring me a glass of milk when you come in here? 
 Take this report card to your father so that he can pay you for all of your A’s. 
 

Can or May 
I cannot believe it! 

 

Cannot should always be  
spelled as one word.     

Can is used in reference to ability.  May refers to permission. 
 

You may begin this exercise whenever you can get 
around to it. 

 

Cannot or Can not  
The correct spelling is always cannot. 

 

You cannot blame him for screaming, “Stop it, Bob!”  
 

Capital or Capitol 
Capital means “most important.”  It also names the city or town that is the official center of government 
for a state or country.  The building where a state legislature meets is referred to as the capitol.  The 
building in Washington, D.C., where the United States Congress meets, is referred to as the Capitol. 

 

My capital reason for moving to Hartford is because it is the capital of Connecticut.  
We went over to the capitol to see the legislators.  
Farmers protested outside the Capitol in Washington, D. C. 

 

Choose or Chose 
Chose is the past tense of choose which means “to select.” 
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I chose the red balloon. Now you choose a balloon of another color. 



 

 

Cite or Sight or Site 
A reference is cited (documented).  Sight is vision.  A site is a place. 

 

Please cite the passage from Genesis. 
The sight of the old house brought tears to her eyes.  
She chose this site because of its view.  

 

Clothes or Cloths 
Clothes are garments that people wear.  Cloths are pieces of material or rags.   

 

His clothes were made of cloths of many different colors. 
 

Coarse or Course 
Coarse is an adjective meaning “rough” or “crude.”  Course is a noun meaning “a pathway of action.” 

 

Dylan uses coarse language when he speaks with his friends.   
His parents are hoping that the language course will help him realize how uneducated he sounds. 

 

Collage or College 
A collage is a collection of miscellaneous items.  College is an institution of higher education. 

 

Since this is my senior year of high school, I think I’ll create a picture collage of miscellaneous 
high school memories to hang in my dorm room next year when I’m away at college. 

 

Complement or Compliment 
Complement means “an addition to” or “to add to” or “to complete.”  Compliment means “praise” or “to 
praise.” 

 

A matching hat complemented her new outfit.   
He complimented her on her outfit. 

 

Conscience or Conscious 
Conscience refers to a person’s sense of right and wrong.  Conscious means “aware,” “awake,” or 
“deliberate.” 

 

She does not seem conscious of the fact that her husband has no conscience. 
 

Council or Counsel 
Council refers to a group discussing and taking action on official matters.  Counsel means “advice” or “to 
advise.” 

 

Mr. Vickers has suggested that I counsel the student council on the format of parliamentary 
procedure. 

 

Desert or Dessert 
The noun desert means “a dry, barren region.”  The verb desert means “to abandon.”  Dessert is a sweet 
food at the end of a meal. 

 

Any cool dessert would taste great out here in the sandy desert. 
While eating my dessert, I realized that my date had not only deserted me but also left me with 
the bill. 
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Disinterested or Uninterested 
A disinterested person is one who is neutral or unbiased.  An uninterested person is one who is not 
interested or unresponsive to an issue. 

 

You will want a disinterested (impartial) judge.  
An uninterested (not interested) judge, however, is a liability. 

 

Effect (see Affect) 
 

Ensure (see Assure) 
 

Except (see Accept) 
 

Farther or Further 
Farther refers to physical distance.  Further means “to a greater degree or extent.” 

 

I can run farther than you, but let's discuss that further after the race. 
As you go farther away, your ability to hear is further decreased.  

 

Fewer or Less 
Fewer refers to items that can be counted.  Less is used with items that cannot be counted. 

 

She has fewer complaints (can be counted), but she has less energy (cannot be counted). 
 

Formally or Formerly 
Formally means “in an elegant or standardized manner.”  Formerly means “previously.” 

 

Formerly, we met formally to discuss these matters. 
 

Good or Well 
Good is always an adjective, never an adverb.  It describes a noun or a pronoun.  Well is primarily used as 
an adverb to mean “done in a satisfactory way.”  Thus, well can be used to show how an action has been 
performed.  If a person is talking about a person’s health, use the adjective well, which means “in good 
health.” 

 

She's a good swimmer. 
She swims very well.   (NOT—She swims real good.) 
How are you?  I’m well.  (NOT—I’m good.) 

 

Have or Of 
Have should be used instead of the preposition of after the verbs could, would, should, might, must, and 
may.  Since the contraction form of these verbs combined with have sounds like could “of ” (could’ve), 
people often mistake the sound “of ” for the word of rather than for the contraction of have. 

 

 She could have worked all night.   She could’ve worked all night. 
 She would have been paid well.   She would’ve been paid well. 
 She should have taken the opportunity  She should’ve taken the opportunity. 
 She might have enjoyed the night shift.  She might’ve enjoyed the night shift. 
 She must have had other things to do.  She must’ve had other things to do. 
 She may have regretted it later.    She may’ve regretted it later. 
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If or Whether 
If implies an alternative.  Whether implies a condition of doubt.  

 

If it does not rain, we will decide whether to have a picnic.  
 

Illusion (see Allusion) 
 

Insure (see Assure) 
 

Imply or Infer 
Use imply to mean “suggest” or “hint.” Use infer to mean “surmise” or “draw a conclusion.” 

 

His tie and shirt colors imply (suggest) that he may be colorblind.  
He is not colorblind; thus, we infer (surmise) that he merely has wretched taste. 

 

It’s or Its 
The contraction of “it is” or “it has” is it’s.  Its is the possessive form of “it.”  

 

That kitten has lost its mitten. 
What color is the mitten?  It’s green.  
It’s been missing for several hours now. 

 

Lay or Lie 
Lay is a verb that means “to place” or “to put.”  Lay always takes a direct object.  Lie means “to recline, 
rest, or stay” or “to say something that is not true.”  Lie never takes an object. 

 

Many people confuse these because the verb tenses are similar.  The forms of lay are lay, laid, and laid.  
The forms of lie are lie, lay, and lain. 
 

 Lay: I lay a blanket on the bed. (present tense)  I laid a blanket on the bed. (past tense) 
  I have laid a blanket on the bed. (past participle) 

 

 Lie: I must lie down to take a nap. (present tense)  Earlier, I lay down to take a nap. (past 
  tense) 
  At times, I have lain down to take a nap before going to the gym. (past participle) 
 

Lead or Led 
Lead (pronounced lēd) means, “to go first.”  Lead (pronounced lěd) is a heavy metal.  Led is the past 
tense of lead (lēd). 

 

As he began to lead his soldiers into battle, his feet seemed to be made of lead. 
 

Less (see Fewer) 
 

Like (see As) 
 

Loose or Lose 
Loose means either “not tight” or “free and untied.”  Lose means “to be unable to find or keep.”  It is 
also the opposite of win.   

 

My shoes are so loose that it is quite possible that I might lose one. 
 

May (see Can) 
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Moral or Morale 
Moral refers to rules or habits of conduct.  Morale refers to the spiritual state of an individual or a 
group. 

 

The moral of this story is that the morale of a military unit is extremely important. 
 

Number (see Amount) 
 

Of (see Have) 
 

Passed or Past 
Passed is the past tense of the verb pass.  Past is a noun or an adjective referring to something that 
belongs to an earlier time.  Past is also used as a preposition to mean “beyond.” 

 

Whatever has passed us by is now in the past.  
Mrs. Metzler never drives past Dairy Queen without stopping for a Diet Coke. 

 

Patience or Patients 
Patience means “endurance.”  Patients are people under the treatment of a physician.  

You must have patience in dealing with the patients in this clinic. 
 

Peace or Piece 
Peace means “tranquility.”  Piece is a portion of a larger object. 
 I am always calm and at peace when I eat a piece of pie. 

The period of peace between the two wars is an interesting piece of history. 
 

Personal or Personnel 
Personal means “of a person.”  Personnel refers to the people in an organization, especially employees. 

The personnel office had a great deal of personal information in its files. 
 

Precede or Proceed 
To precede means “to go ahead of ” or “to come before.”  To proceed is to go forward. 

 

We will now proceed to the act that should precede the ending of the play. 
 

Principal or Principle 
Principal means “leading, chief, or highest in importance.”  An easy way to remember that a principal is 
the leader of the school is to consider him or her to be your “pal.”   Principle refers to a basic truth, 
rule, or law. 

 

The high school principal said that the principal problem with today's youth is a lack of 
principles. 
The principal author gave the lecture.  He acts according to the highest principles. 

 
Raise or Rise or Rear 
Raise as a verb means “to cause to move upward.”  It always takes a direct object.  Rise as a verb means 
“to get up.”  It never takes an object. 

 

Please do not raise your voice to me. 
My mother and father rise before dawn every day. 
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We do not raise children.  We rear children—unless they grow up like animals; in which case, we can 
say we have “raised” them.  

 

Real or Really  
Real is an adjective meaning “genuine” or “sincere”; really is an adverb meaning “actually” or “very.”  In 
informal English, people sometimes use real as either an adjective or adverb; however, this is 
nonstandard. 

 

Regardless of what  
you hear people say,  
you should learn that 
irregardless is not a word. 

These sociologists have made a really (not real) important contribution to our understanding of 
some real problems in urban America. 

 

Regardless or Irregardless 
Regardless means “in spite of ” or “anyway.”  Irregardless is 
not a word. 

 

Regardless of what you may have heard, you should 
learn that “irregardless” is not a word. 

 

Right or Rite or Write 
Right means “correct,” “the opposite of left,” or “privilege.”   Rite means “ritual.”  Write 
means “to put something on paper.” 

 

He had no right to write a new rite for the church.  
 

Role or Roll 
A role is a position or a part.  Roll as a verb means to “rotate” or “revolve.”  Roll as a noun means “a reel” 
or “a spool.”  
 

In his role as an absent-minded professor, Ben Martin called the roll of the wrong class. 
 

Sense or Since 
Sense as a noun means “intelligence,” “meaning,” or “feeling.”  Sense as a verb means “to feel.”  Since can 
be used as a conjunction to mean “as” or as an adverb to mean “from the time when.”   
 

He doesn't seem to have much sense ever since he fell on his head. 
 

Set or Sit 
Set means “to place” or “to put”; it takes a direct object.  Sit means “to place oneself in a sitting 
position.”  It does not take an object.   

 

Set the cake on the kitchen counter.  
If I’m not there to pick you up after school, just sit on the bleachers and wait for me. 

 

Sight (see Cite) 
 

Site (see Cite) 
 

Stationary or Stationery 
Stationary means “not moving, fixed.”  Stationery refers to writing materials like paper and envelopes.  

 

The stationery department, where envelopes and writing paper are for sale, is in a stationary 
place. 
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Take (see Bring) 
 
Than or Then 
Than is a conjunction that introduces a subordinate clause.  Then is an adverb meaning “therefore” or 
“next in order or time.” 

 

Is Valerie older than I am?   
If she is older, then she will be eligible for a driver’s license before I. 

 

That or Which or Who 
That refers to things or anonymous people.  Use that to introduce an essential clause (one that is 
needed to complete the intended meaning of a sentence).  Use which to introduce a nonessential clause 
(one that adds additional information to an already complete sentence).  Use who to introduce a clause 
that refers to people. 

 

 Where is your shirt that has a stain on it?   
Was it the person that spilt his drink everywhere that caused the stain? 

 I selected a shirt, which is blue and green, to give to my father for his birthday. 
 Mr. Hertzog, who coaches wrestling, is a graduate of Lee’s Summit High School. 
 

Their or There or They’re 
Their is the possessive form of “they.”  There means “in that place.”  They’re is the contraction for 
“they are.” 

Through with Thru 
 

The word thru is not  
standard English.   
Use through instead. 

They’re driving their new car over there this afternoon. 
 

Thorough or Threw or Through or Thru 
Thorough means "complete."  Threw is the past tense of “throw” 
which means “to toss.”  Through means “during” or “because of    ” 
when used as a preposition, “from beginning to end” as an 
adverb, and “finished” as an adjective.  Thru is not standard 
English.  
  

The neighbor made a thorough report to the police after Freddie threw a baseball 
right through the neighbor's front window.  

 

To or Too or Two 
To means “toward” or “as far as.”  Too means “also” or “extremely.”  Two is the number 2. 

 

In two hours, it's going to be too hot to go to town. 
 

Uninterested (see Disinterested) 
 

Wander or Wonder 
Wander means “to stroll” or “to drift.”  Wonder as a verb means “to speculate” or “to marvel”; wonder as 
a noun refers to a surprise or phenomenon. 
 

I used to wonder how he could just wander around the city like that. 
 

Well (see Good) 
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We’re or Were or Where 
We’re is the contraction for “we are.”  Were is a past tense verb of “to be.”  Where refers to a location. 

If we’re going to the 7:00 movie, then we need to leave now. 
Where were you yesterday?  
 

Weather or Whether (also see If) 
Weather refers to the condition of the atmosphere, such as its heat or cold, wetness or dryness.  
Whether indicates a choice between two things. 

 

I don't know whether we'll go or not. I think it depends on the weather. 
 

Which (see That) 
 

Who (see That) 
 

Who or Whom 
Who is used as a subject wherever the words I, she, or he could be used.  Whom is used as an object 
wherever the words me, her, or him could be used. 

 

We should write a thank you note to the person who gave us this adorable puppy. 
That's a great idea.  To whom should I address the letter?  

 

Who’s or Whose 
Who’s is the contraction for “who is” or “who has.”  Whose is the possessive form of who. 

 

Who’s running in the marathon this weekend? 
Whose sandwich is that?  

 

Your or You’re 
Your is the possessive form of you.  You’re is the contraction for “you are” or “you were.”   

 

You’re doing your own homework, I hope. 
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PPRREEFFIIXXEESS    
 A prefix is a combination of letters placed before a word or word to modify the meaning of the 
original word. 
 The Greek root “graph” means “to write.”  “Geo” means “earth,” so “geography” is “writing about 
the earth.” 
 “Bio means “life” so a “biography” is “writing about someone’s life.” 
 “Chron” means “time” so a “chronograph” is “time writing” and the word we now use for a digital 
watch.   
 
a-,an-  not, without   intra-  within, among 
ab-  from, away, not   mal-  hate, poorly 
acro-  high    meta-  beyond, after 
ad-  to, near, at   mis-  incorrect 
ambi-  around, both   mono-  one 
ana-  throughout, up   multi-  many 
ante-  before    neo-  new 
anti-  against    non-  not 
bene-, bon- well, good, kind   ob-  towards, against 
bi-  two    omni-  all 
cata-  down, through   para-  beside, almost 
chron-  time    penta-  five 
circum-  around    per-  completely 
co-,com-,con- together, with   poly-  many 
contra-  against    post-  after 
de-  from, away, down  pre-  before 
di-  double, two   pro-  forward 
dia-  through, between  pseudo- false 
dis-  apart, not   re-  back, again 
em-, en- in, into    retro-  backwards 
epi-  upon    semi-  half 
es-  out, away   sesqui-  one and 1/2 
ex-  out    sub-  under 
estra-, exto beyond, outside of  super-  beyond, over 
fore-  before in time   syl-,sym,syn- with, together 
hemi-, demi- half    trans-  across 
homo-  man    tri-  three 
hyper-  over,  above   un-  not 
hypo-  under, beneath   uni-  one 
il-, ir-, in-, im- not    ultra-  beyond, exceeding 
inter-  between   vice-  in place of 
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SSUUFFFFIIXXEESS                          
 

        Makers of Nouns     Maker of Verbs 
-al – arrival, betrayal, portrayal, refusal  -ate – alleviate, annihilate, compensate  
-ance – connivance, maintenance, nonchalance  -ify – amplify, deify, gratify 
-ence – acquiescence, deference, iridescence  -ize – amortize, burglarize, ostracize  
-dom – kingdom, officialdom, wisdom         
-hood – brotherhood, motherhood, neighborhood            Makers of Adverbs   
-ship – discipleship, friendship, partisanship  -ly – adroitly, astutely, complacently  
-ee – appointee, draftee, nominee, repartee   
-er – abstainer, embezzler, loiterer       Versatile Suffixes 
-ess – actress, princess, seamstress   Certain suffixes may be used to make more  
-ice – apprentice, avarice, novice, service  than one part of speech.  The following  
-ism – pessimism, socialism witticism   suffixes make verbs, nouns, and adjectives, 
-ist – antagonist, plagiarist, psychiatrist  but NOT adverbs. 
-ity – agility, possibility, reliability   -ant – assailant, claimant, occupant (nouns)  
-ty – liberty, loyalty, novelty    exultant, radiant, self-radiant (adjectives) 
-lum – auditorium, curium, presidium   In verbs such as warrant, decant, recant, 
-ment – abridgment, chastisement, curtailment and suppliant, the –ant is part of the root  
-ness – furtiveness, gruesomeness, hopefulness and not a suffix. 
-or – incisor, innovator, mediator     
-(s)ion – depression, obsession, suspension  -ary – aviary, functionary, notar(nouns) 
-(t)ion – abolition, coalition, liberation   arbitrary, mercenary, military (adjectives) 
-ure – expenditure, seizure, verdure    
-y,-ry- empathy, husbandry, irony   -ate – abrogate, deviate, mediate (verbs) 
-cy – adjacency, bankruptcy, complacency  advocate, candidate, potentate (nouns) 
       collegiate, desolate, sedate (adjectives) 
 Makers of Adjectives     
-able – consolable, disposable, readable  -ent – portent, solvent, superintendent   
-ible – contemptible, discernible, irresistible  (nouns)  
-al – abysmal, fiscal, hexagonal   evident, insistent, subsequent (adjectives) 
-ial – connubial, menial, mercurial     
-ual – casual, gradual, manual    -ite – expedite, ignite, incite (verbs) 
-ese – Balinese, Chinese, Japanese   Israelite, satellite, urbanite (nouns)  
-ic – nomadic, prosaic, symphonic   exquisite, favorite, finite (adjectives) 
-tic – aromatic, dogmatic, pathetic     
-ine – bovine, equine, porcine    -ive – derivative, expletive, substantive 
-ile – ductile, infantile, senile               (nouns) 
-ive – cursive, festive, regressive   affirmative, conclusive, decisive  
-ish – bookish, fiendish, greenish   (adjectives) 
-ful – delightful, graceful, neglectful    
-less – defenseless, graceless, hapless   -(r)ior – exterior, interior, posterior 
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-like – homelike, sylphlike, zephyrlike   anterior, inferior, ulterior   
                  (nouns or adjectives) 



 

TTEEAACCHHEERRSS''  PPEETT  PPEEEEVVEESS  
1. Inappropriate abbreviations 

b/c  w/o  b/t  cuz 
 

2. Vague words like etc., it, thing, and stuff 
 

3. Using like or goes to mean said 
Every day in class it’s the same scenario.  My teacher always goes, “Do problems 1-5,” but 
then I’m like, “I don’t want to do more than three,” and, of course, she goes, “Get to work or 
you’ll have to serve a detention,” so I’m always like, “Okay.  I’ll do my work.” 

 

4. Using the following phrases in a paper 
“Hi.  My name is...”    “In this paper I'm going to talk about...” 
“In this paper I've talked about... ” “Thank you for reading my paper...” 
“I hope you liked my paper...”  “The end” 

 

5. Usage errors 
alright instead of all right 
alot instead of a lot 
are instead of our 
can not instead of cannot 
cause instead of because 

defiantly instead of definitely 
irregardless instead of regardless 
of instead of have 
quite instead of quiet  
thru instead of through 

 

6. Extra line spaces between paragraphs 
 

 The Correct Way The Incorrect Way 
 This paper is double-spaced    In this paper, the writer has 
 throughout.  There are no extra added extra line spaces between 
 line spaces between paragraphs paragraphs.  In addition there 
 and no extra line spaces above  are extra line spaces above and 
 or below the title. below the title. 

 
7. Talking to the reader by using the following words 

You  us  we  our 
 

Your Name Your Name 

Name of Teacher 

Name of Class 

1 January 2003 

Title of Your Paper 

 This is the way your essays should be set up in final form.  The text should be typed, 

double-spaced, with a heading in the upper left-hand corner like the one above.  Starting with the 

second page, page numbers go in the upper right-hand corner.  Give your last name and page 

number like this: Smith 2  That’s all; no punctuation is needed. You should put your last name 

and page number in a header.   

Name of Teacher 

 Note that paragraphs are indented five spaces; this is done by hitting the 'Tab' key, not by 

spacing over.  Do not quadruple space between paragraphs and do not justify right-hand 

margins.  Use a black ink cartridge and standard white unlined paper.  It is mandatory to use 

Times New Roman, size 12 font.  You should never use any nonstandard type styles.  Note that 

margins are one-inch on all sides.  This may not be the default setting within your software 

program, so it may require you to manually make the changes.  

 Please do not do anything to your title except to capitalize the first letter of important 

words.  This means do not underline your title or put it in quotes.  Do not include a separate title 

sheet.  Simply begin your paper as I have done here.  Please do not use any special folders or 

covers.  Staple the paper neatly in the upper left-hand corner. 

 

8. Neglecting to proofread 
 

9. Inconsistent verb tense throughout the paper 
 

10. Not identifying the person quoted in the paper 
 

11. E-mailing your paper to your teacher without permission 
 

12. Incorrect number usage. Spell out numbers written in one or two words and represent 
 other numbers by numerals. 

    one  thirty-five  one hundred  fifteen hundred 
   101  137   1,275   23,498 
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Name of Class 

1 January 2003 

 

Title of Your Paper 

 

 This is the way your essays should be set up in final form.  The text should be typed, 

double-spaced, with a heading in the upper left-hand corner like the one above.  Starting with the 

second page, page numbers go in the upper right-hand corner.  Give your last name and page 

number like this: Smith 2  That’s all; no punctuation is needed. You should put your last name 

and page number in a header.   

 

 Note that paragraphs are indented five spaces; this is done by hitting the 'Tab' key, not by 

spacing over.  Do not quadruple space between paragraphs and do not justify right-hand 

margins.  Use a black ink cartridge and standard white unlined paper.  It is mandatory to use 

Times New Roman, size 12 font.  You should never use any nonstandard type styles.  Note that 

margins are one-inch on all sides.  This may not be the default setting within your software 

program, so it may require you to manually make the changes.  

 

 Please do not do anything to your title except to capitalize the first letter of important 

words.  This means do not underline your title or put it in quotes.  Do not include a separate title 

sheet.  Simply begin your paper as I have done here.  Please do not use any special folders or 

covers. Staple the paper neatly in the upper left-hand corner.



 

TTRRAANNSSIITTIIOONN  TTEECCHHNNIIQQUUEESS  
Transitional words and phrases will help you link ideas within and between paragraphs. 
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To Show Time Sequence 
    

after during first, second, third meanwhile 
at the same time earlier in a few minutes next 
before finally later then 
    
    

To Compare or Contrast 
    

although despite nevertheless similarly 
But however on the contrary still 
by contrast in like manner on the other hand unlike 
conversely likewise otherwise yet 
    
    

To Show Cause and Effect 
    

as a result consequently so therefore 
because of on account of then thus 
    
    

To Add More Information 
    

Again another first, second, third in addition 
Also as well further moreover 
And besides furthermore too 
    
    

To Emphasize a Point 
    

as a matter of fact evidently in other words obviously 
clearly in fact indeed thus 
    
    

To Introduce Examples or Explanations 
    

as an illustration for example in particular that is 
 for instance namely  



 

CCAAPPIITTAALLIIZZAATTIIOONN  
 

1. Capitalize the pronoun I. 
 

2. Capitalize names of particular people, places, organizations, business firms, institutions, 
and government bodies. 

John Faulkenberry    Sprint 
Longview Community College  Congress 
Girl Scouts 

 

3. Usually capitalize first words in lines of poetry. 
Hickory, dickory, dock 
The mouse ran up the clock 

 

4. Do not capitalize junior high or high school unless it is the name of a specific school.  
Lee’s Summit High School 
I am in high school. 

 

5. Do not capitalize the name of a class  
When I was a freshman, I couldn't wait to be a senior. 

 

6. Capitalize all course titles that are followed by a number or letter. 
My best class is Algebra I. 
Did you say that History III meets in the computer lab today? 

 

7. Do not capitalize a subject unless it is derived from a proper noun. 
My best subject is algebra. 
I really like my English, Spanish, and history classes. 

 

8. Do not capitalize seasons  
Every year during the winter season, I cannot wait for spring to arrive. 

 

9. Capitalize geographical names. 
Lee's Summit, Missouri 

 

10. Do not capitalize words that indicate direction. 
Walk four miles north on 291 to Third Street then east to the store. 

 

11. Capitalize words that show a particular region of a country or of the world.  A clue is 
that the word the often precedes a direction that should be capitalized. 

The Southern coast is beautiful. 
I live in the Midwest. 
I lived in the East for ten years. 

 

12. Capitalize titles of people when they are followed by the name. 
Uncle Joseph   Dr. Stansberry 
Senator Jones   Coach Anderson 

 

13. Capitalize titles of people in very high national or state offices even when not followed 
by the name. 

Every American President has had to face problems. 
The Secretary of State has left for Europe. 
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14. Capitalize the title of a person when it is used in place of a name. 
Will you come with me, Mom? 
Good morning, Professor. 

 

15. Do not capitalize words of family relationships when used with a possessive pronoun. 
I like to hang out with Jim, my cousin. 
I like to hang out with Cousin Jim. 
Your aunt is a great cook. 
Yesterday, Aunt Stacey took me shopping. 

 
16. Capitalize the first words and all important words in a title of a work.  (Prepositions of 5 or 

more letters are capitalized). 
The Last of the Mohicans 
For Whom the Bell Tolls 

 

17. Capitalize the first word of a quoted sentence. 
Mr. Russell said, “Treat her as you would like to be treated.” 
“I think,” she screamed,  “you almost drove over the bike!” 

 

18. Capitalize the first word of a salutation and the first word of a complimentary close. 
Very truly yours, 
Dear _____, 

 

19. Capitalize the names of weekdays, months, and holidays. 
I’m going to the movies on Friday. 
A very busy month for me is May. 
My favorite holiday is Halloween. 

 

20. Capitalize the names of religious icons. 
Jesus Christ   His word 
God    Bible 
Allah 

 

21. Capitalize the name of races, religions, peoples, and nationalities. 
African    Asian 
Catholic   Jewish 

 

22. Capitalize trade names or copyrighted names, but do not capitalize the name of the 
product. 

Chevy truck 
Nike shoes 
Dell computer 

 

23. Capitalize historical events, monuments, awards, and time periods. 
Ice Age   Mount Rushmore 
Middle Ages   World War II 
Tony Award 

 
24.Capitalize the abbreviation for time:  B.C. (“before Christ”), which follows a date; and 

 A.D. (“anno Domini”), which precedes a date as well as A.M. and P.M. 
  40 B.C.    4:00 P.M. 
  A.D. 70   7:00 A.M. 
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NOTE: Because she screamed interrupts 
the dialogue (the part in quotation marks), 
the remainder of the dialogue does not 
begin with a capital letter. 



 

AAPPOOSSTTRROOPPHHEESS’’  
 

1. Use an apostrophe to indicate missing letters or numbers.    
 

  you are = you’re do not = don’t    
  1993 = ‘93  good morning = good mornin’  
 

2. Use an apostrophe and s to form the plural of a letter, number, or a word discussed as a 
word. 
 

  How many A’s do you have on your report card? 
  Count the 8 ’s on the page. 
  You’ve used too many and ’s in the paper. 
Use an apostrophe to show possession.  To form the possessive of a singular noun, add an ‘s. 
 

  Mark’s book  my sister-in-law’s car 
  the Jones’s house Chris’s locker 
 

3. Make a plural noun ending in an s possessive by adding just an apostrophe. 
  

the girls’ house (More than one girl lives there.) 
 my bosses’ policy (I have more than one boss.) 

 

4. When a plural noun does not end in an s, form the possessive by adding an apostrophe 
and an s. 
 

  the children’s book (The book belongs to more than one child.)   
the men’s restroom 

 

[[BBRRAACCKKEETTSS]]  
 

1. Use brackets to insert one parenthetical comment inside another. 
 

I left my new leather coat (which cost me $300 [my entire savings] ) in the cafeteria. 
 

2. Use brackets to insert your own editorial comments into quoted material.  Brackets are 
used to enclose the letters sic to indicate that the speaker, not the writer, made an 
error. 

 

Priest Holmes said, “T-Rich [Tony Richardson] is an essential part of the Chief’s offense.” 
Priest Holmes said, “The noise from the 700,000 [sic] fans in the stadium helped us win 
the game.” 

 

CCOOLLOONNSS::  
   

1. Use a colon after a salutation in a business letter. 
 

Dear Mr. Schnell: 
To Whom It May Concern: 

 

2. Use a colon to add emphasis or to explain a clause. 
 

There are two words for my younger brother:  irritating and annoying. 
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3. Use a colon to introduce a long, formal quotation; a list; or examples. 
 

For this recipe, you will need the following ingredients:  butter, eggs, flour, sugar, 
baking soda, salt, and milk. 

 

4. Use a colon when writing times, ratios, literary references, or volume numbers. 
 

7:30 p.m. (or P.M.) 
The vote was 49:1. 
John 3:16 
Newsweek 49:1 
 

5. Use a colon between the clauses of a compound sentence when the second clause 
explains the first or amplifies it. 

 

Rachel could say no more: we had convinced her. 
The climbers tired soon: they were not used to the thin air. 
 

CCOOMMMMAASS,,  
1. Use a comma or commas to set off (surround) a term in direct address, also known as 

the noun of address. 
Pauline, are you ready? 
Watch out, Zach, for the shopping cart.  
I am here, Mrs. Jones. 

 

2. Use a comma to set off yes, no, well ; other introductory words or phrases; mild 
interjections; and parenthetical expressions (words not necessary to the meaning of the sentence). 

Oh, we won’t need it. 
Well, I’ll go then. 
By the way, do you know them? 
His brother, on the contrary, is very sociable. 
Ethan, needless to say, had missed the bus. 

 

3. Use commas to set off the year when three parts of a date are given.  Use no commas in 
a two-part date. 

On Friday, November 23, 1990, I attended my first school dance. 
The climate during June 1971 was very humid in Missouri. 

 

4. Use commas between parts of an address.  (State and ZIP number form one part.)  Within a 
sentence, use a comma after the end of the address if it is not the end of the sentence. 

Apply to the Art Academy, 4708 Fir Street, Kansas City, MO 55105. 
Is  400 SE Blue Parkway, Lee’s Summit, MO  64086, the correct address for Lee’s Summit 
High School?  
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5. Use commas after digits indicating thousands except in such items as dates or street 
numbers. 

1,236   1236 South Winnebago Drive 
A.D. 1236  1,027,884 

 



 

6. In alphabetical listings of names, as in directories or bibliographies, use a comma after 
the surname (a person’s last name). 

Dempsey, Patrick 
Lovelace, Dr. Rebecca M. 
Jones, James E. 

 

7. Use commas to set off a title or the abbreviation of a title following a name. 
James P. Bradford, Jr., is the coordinator of student activities. 

   

8. Use commas to separate the items in a series of words, phrases, or short clauses. 
The team, band, and fans were tense with excitement. 
We drove under the suspension bridge, up the hill, and into the picnic grounds. 
Lucy studied, Ricky daydreamed, and I fell asleep. 
 
 
 

9. Use a comma to show the omission of words. 
I was wearing a topcoat; Louis, only a jacket. 

 

10. Use commas to set off adjectives that follow the noun they modify. 
The boys, breathless and exhausted, stood waiting. 

 

11. Use commas to separate consecutive adjectives if each one modifies the noun alone.   
 

I heard his hearty, contagious laugh. (hearty laugh, contagious laugh) 
 

One way to spot these instances is if the word and can be substituted or if the two 
  adjective modifiers can be flipped and the sentence retains the same meaning. 

   

I heard his hearty and contagious laugh. 
I heard his contagious, hearty laugh. 

   

If an adjective modifies an adjective-noun combination, omit the comma.   
 

This is a compulsory medical examination.  
(Compulsory modifies medical examination, not just examination.) 

 

Again, check to see if the words can be separated by and or flipped around.  If they  
  cannot, then no comma is used in the original sentence. 
 

This is a compulsory and medical examination. —NO! 
This is a medical compulsory examination. —NO!   

 

12. Use commas to set off words or word groups that are appositives unless the appositives 
are short and closely connected (necessary for clarity). 

Jenna Lambert, a science student, built this project. 
My brother Simon called. 
The poem “Cargoes” is by Masefield. 

 

13. Use a comma or commas to set off a direct quotation. 
Hillary replied, “It’s in the dining room.” 
“Where,” Cody asked, “were you?” 

 

14. Use commas to set off contrasted elements. 
This classroom, unlike the hallway, was cool. 
Greg, not Peter, is her brother. 
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NOTE: Because Cody asked interrupts the 
dialogue (the part in quotation marks), the 
remainder of the dialogue does not begin 
with a capital letter. 



 

15. Use a comma wherever needed for clear meaning. 
To Mary, Beth seems shy. In 1980, 920 permits were issued. 
What the reason is, is unclear. Outside, the house looked in good repair. 

 

16. Use a comma after complimentary closings in all letters.  Use a comma after the 
salutation of a friendly letter. 

Yours truly,   Dear Reagan, 
Lovingly yours,   Dear Uncle Mitchell, 

 

17. Use a comma before a short clause that changes a statement into a question. 
It was a long trip to our summer camp that day, wasn’t it? 
He won’t do that again, will he? 
 

18. Use a comma or commas to set off sections of the sentence that give incidental or 
supplementary information.  Omit the commas if the clause or phrase is restrictive 
(necessary) to the sentence idea.  A clause beginning with that will always be restrictive 
and, therefore, will not be set off by commas. 

Officer Keck, who is always alert, saw the collision. (nonrestrictive) 
The crossing that we were approaching was a dangerous one. (restrictive) 
Millie, bursting with the news, walked toward us. (nonrestrictive) 
Do you know the girl standing near Miss Cole? (restrictive) 

19. Use a comma with a conjunction to separate the clauses of a compound sentence unless 
they are very short clauses. 

 

DDAASSHHEESS——  
   

1. Use dashes to indicate a sudden break or change in the sentence.  They are often used 
to emphasize a word, phrase, or clause.  The dash consists of two hyphens without 
spacing before or after them. 

The lecture was dull—painfully dull. 
The schools in this area—especially those in Lee’s Summit—attract the finest teachers. 
 

EELLLLIIPPSSEESS  ..  ..  .. 
 

1. Use ellipses to indicate that some words have been left out of a quotation.  Be careful 
not to leave out crucial words from the quotation.   

 

In his address to the student body, Mrs. Barger said, “Due to the weather conditions, 
school will dismiss at noon . . . Bus service will be provided, but delays are expected.” 
   

2. Use ellipses to indicate a pause. 
   

  I don’t have . . . well, maybe I . . . has anyone seen my homework? 
  

EXEXCLAMATION  POINTS!  PCLAMATION OINTS!
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1. Use ONE exclamation point to express strong feeling when making a request or 
statement.  Use exclamation points sparingly! 
 



 

  That is amazing! 
  Get out of here! 
   

2. Place the exclamation point inside the quotation marks if it is part of the quotation.  
Place it outside the quotation marks if it is not part of the quotation. 
 

As she chased the wolves away from the chickens, she shouted, “Get out of here!” 
I can’t believe that he said the words, “I love you” ! 

 

3. Compound sentence unless they are very short clauses. 
Public education is free, but a student has various subsidiary expenses. 
Josh arrived in the morning, and Roger followed him later in the day. 
You read and I’ll listen. 
Mr. Kenney played the piano and we sang. 

 

4. Use commas to set off clauses and phrases that are introductory or noticeably out of 
their normal places in the sentence. 

 

Before Mr. Reece put the microscope away, he cleaned it carefully. 
Because you were not paying attention, you missed the assignment. 
I shall, as soon as I can, bring you a full report. 

 

5. Use commas to set off introductory phrases such as these:  
To get the latest news, Dad turned to WFMT. 
After that first long and exhausting day, I began to enjoy the summer. 
Between the fingers of his right hand, he held three coins. 
The weather having improved, the streets were again filled with people. 

 

HYHYPHENS-    PHENS-
1. Use a hyphen to make a compound word. 

 mother-in-law  president-elect  
 

2. Use a hyphen to join a capital letter to a word. 
 

  T-shirt   U-turn 
 

3. Use a hyphen to form new words beginning with the prefixes self, ex, all, great, and 
half.  It is also used with other prefixes to avoid confusion. 
 self-taught 

post-war   
 re-cover (not recover) the furniture 
 shell-like (not shelllike) covering 
   

4. Use a hyphen to join two or more words that combine to form a single adjective before 
a noun.  If this type of adjective follows the noun, there are no hyphens. 
 

  Our school is equipped with up-to-date technology. 
  Our school’s technology is up to date. 
  The Franco-Prussian War was quite controversial.   
 

5. Use hyphens in certain numerical expressions. 
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  twenty-five, sixty-two (for numbers 21 to 99) 
  two-thirds full (in fractions used as adjectives or adverbs) 



 

  We won 72-55. (in scores) 
  Read pages 35-47. (to mean through) 
 

6. Use hyphens to divide a word at the end of a line of print.  Words are divided only 
between syllables, but do not leave one letter by itself.  
   

  Most of the time when you’re writing by hand or on the com- 
puter, you do not have to worry about hyphenation; but when 
you do have to hyphenate, pay careful attention to word divi- 
sion rules.    

  

IITTAALLIICCSS  
1.  Use italics to indicate the titles of books, films, plays, long poetry, ballets, operas,  
    magazines, newspapers, television programs, pamphlets, CD’s, legal cases, and the       
    names of ships and aircraft.  When the title is handwritten, the words that should be   
    italicized in print are underlined. 

 

Of Mice and Men 
Hamlet 
Lee’s Summit Journal 

2.  Use italics to distinguish a particular word or to denote foreign and scientific     

           language. 
  I will look up the word democracy in the dictionary. 

Muchas gracias for your help on my Spanish project.     

(P(PARENTHESES)  ARENTHESES)
1. Use parentheses to enclose supplementary information that interrupts the flow of the 

normal sentence structure.   
  I forgot to study for today’s vocabulary test. (I usually remember.) 

The hockey team (except Spencer) played well. 
  

PPEERRIIOODDSS..  
1. Use a period after a complete sentence that is a command, request, or statement. 

Answer the question using a complete sentence. 
        Please work quietly. 
        I know how to write a complete sentence. 
   

2. Use a period after initials and most abbreviations.  Abbreviations using all uppercase 
letters typically do not use periods.  If an abbreviation comes at the end of the 
sentence, do not add another period.  (This final rule does not apply to question marks and exclamation 

points.) 
  

W. C. Fields  
Dr., Mrs., Jr., B.C., Ph.D., U.S. 
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PTA, CIA, PSAT, YMCA, AIDS, ESPN, SW (southwest) 
 He will arrive at 7:00 p.m. (or P.M.) 
 Will he arrive at 7:00 p.m.?  



 

3. Use a period as a decimal point. 
The company lost over $4.5 million last year. 

   

4. Use a period after each Roman numeral, letter, and number in an outline. 
 

I. Fall team sports for boys 
   A.  Soccer 
   B.  Football 
        1.  Competitive 
        2.  Intramural 
II. Fall team sports for girls 
 

5. Always place the period inside the quotation marks that end the sentence. 
 

George Carlin said, “Don’t sweat the petty things and don’t pet the sweaty things.” 

  
QQUUEESSTTIIOONN  MMAARRKKSS??  
 

1. Use a question mark after a question but not after indirect questions. 
 

Who knows when to use a question mark? 
I’m wondering who knows when to use a question mark.   
   

2. Place the question mark inside of the quotation marks if it is part of the quotation.  
Place it outside of the quotation marks if it is not part of the quotation. 

Who said, “A successful book is not made of what is in it, but what is left out of it”? 
I have to ask, “Who knows when to use a question mark?” 

 

3. Use a question mark in parentheses to show uncertainty.   

  The writer lived from 1620 (?) to 1659. 
   

4. A question mark or period may be used after a request. 
 

  Would you please work quietly? 
  Would you please work quietly.  (also correct) 
 

““QQUUOOTTAATTIIOONN  MMAARRKKSS””  
 

1. Use quotation marks to enclose what someone says but not what someone is thinking.  
Quotation marks are not used with indirect quotations. 

 

  Mr. Fox said, “Finish this assignment by tomorrow.”  
  I wondered when I would have time to work on the assignment. 
  I told Mr. Fox that I would need more time to complete the work. 
 

2. Use single quotation marks to punctuate a quotation within a quotation. 
 

  “Read ‘Building and Punctuating Sentences’ for tomorrow,” said Mrs. Allison. 
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3. Place periods and commas inside quotation marks.   
 

  “I must cancel the test,” Mrs. Little announced sadly. 
 



 

4. Place semicolons or colons outside the quotation marks. 
 

  No one volunteered to sing “The Star Spangled Banner”; it is such a difficult song. 
 

5. Place exclamation points or question marks inside quotation marks when punctuating the 
quotation; they are placed outside when they punctuate the entire sentence. 

 

  I panicked when Mrs. Hitman asked, “Will you explain the use of semicolons?” 
  Have you memorized the words to “The Star Spangled Banner”? 
 

6. Use quotation marks to punctuate titles of songs, poems, short stories, short poems, 
lectures, television episodes, book chapters, and articles from magazines, newspapers, 
and encyclopedias. 

 

  “The Star Spangled Banner” is a difficult song to sing. 
  “Verbal Abuse” is the most compelling chapter in your grammar book. 
  Mr. Hensley appeared in “Force of Nature,” an episode from Star Trek. 
 

7. Use quotation marks to distinguish a particular word, to indicate slang, or to point out 
that the word is being used in a special way.   

 

  I looked up the word “democracy” in the dictionary. 
  Mrs. Carpenter couldn’t help but show off her “rad” car. 
  I am “a-maized” how good this corn tastes! 
   

Note:  Italics may be used instead of quotation marks in the examples above. 
 

I looked up the word democracy in the dictionary. 
  Mrs. Carpenter couldn’t help but show off her rad car. 

I am a-maized how good this corn tastes! 

  

I have rewritten—often several times—every word I have ever published.  My pencils outlast their 
erasers. 

 

--VLADIMIR NABOKOV 

SSEEMMIICCOOLLOONNSS;;  
   

1. Use a semicolon between two sentences (independent clauses) that are closely related.   
 

Use semicolons between independent clauses; use colons to introduce a list. 
   

2. Use a semicolon before words like however, also, besides, for example, in addition, 
instead, meanwhile, then, and therefore when they connect independent clauses. 

 

Exclamation points help convey emotion; however, some writers tend to overuse 
them. 
Exclamation points help convey emotion.  Some writers, however, tend to overuse 
them. 
   

3. Use semicolons to separate groups of words that already contain commas. 
 

I am going to Los Angeles, CA; Las Vegas, NV; and Orlando, FL. 
Before we can leave on vacation, I must go to the bank for traveler’s checks, 
passports, and cash; I must stop our mail and newspaper delivery; and I must pick up 
some medication, cosmetics, and film at the pharmacy.  
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SSECTION  5:    GLOSSARIES  OF  TERMS  5: G TECTION LOSSARIES OF ERMS
  
GGRRAAMMMMAARR  GGLLOOSSSSAARRYY  
 
             

   Noun—a word that names a person, place, thing, or idea      
             

  

  Brad Pitt   locker 
  Lee’s Summit High School truth 
 

Collective noun—a noun that refers to a group of people 
 

  class    family 
  committee   team 
 

Common noun—a noun that refers to a general class of people, places, things, or ideas 
 

  athlete    apple 
  beach    friendship 
 

Proper noun—a noun that refers to the name of a specific person, place, thing, or idea 
 

  Mr. Anderson   July 
  Lee’s Summit   Big Bang 
 

Concrete noun—a noun that refers to an object that can be detected by one of the five senses 
 

  apple    music 
  fragrance   pencil 
 

Abstract noun—a noun that refers to a characteristic, quality, or idea 
  

  courage   justice 
  memory   truth    
             

   Pronoun—a word used to replace a noun        
             

 

  I    him 
  everyone   whomever 
 

Personal pronoun—a pronoun that refers to a person or thing 
 

  I    mine 
  me    it 
 

Reflexive pronoun—a pronoun that refers to the subject of the sentence only 
 

  myself    Jason talked himself into studying for the exam. 
  themselves 
 

NOTE:  A reflexive pronoun is neither an object of a preposition nor the subject of a sentence. 
 

Please give your ballot to Mrs. Sprouse or myself.        Please give your ballot to Mrs. Sprouse or me. 
Myself and Mr. Bubalo will be counting the ballots.         Mr. Bubalo and I will be counting the ballots. 
 

Intensive pronoun—a pronoun that emphasizes another noun or pronoun 
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  Jason himself reported the accident. 
 

Demonstrative pronoun—a pronoun that points out a particular person, place, thing, or idea 
 

  That is amazing!  Those are my keys. 
  This is my boyfriend.  These are the places I’ve lived. 
 

Interrogative pronoun—a pronoun that asks a question 
 

  Who    What 
  Which    Which is your paper? 
 

Relative pronoun—a pronoun that joins a dependent (or subordinate) clause to an independent  
(or main) clause 

 

  I love the poem that you wrote.  I appreciate what you have done. 
    (dependent clause)                (dependent clause) 
 

Indefinite pronoun—a pronoun that refers to people, places, things, and ideas in a general way 
 

  everyone   any 
  each    some 
  

Antecedent (of a pronoun)—the word or group of words referred to by a pronoun 
 

Ophelia has lost her mind.  (Ophelia is the antecedent for her.) 
 

Nominative case—forms used as subjects or predicate nominatives 
  

She loves to read.  (subject)  This is she.  (predicate nominative) 
Who loves to read? (subject)  This is who? (predicate nominative) 

 

Objective case—forms that are used as objects  
 

He gave us pie. (indirect object)  My brother hit me. (direct object) 
He gave whom pie? (indirect object) Your brother hit whom? (direct object) 
 
 

Possessive case—forms that show ownership 
 

his book   That book is mine. 

 
             

   Verb—a word that expresses action or a state of being      
             

 

think    succeed 
seems    is 

 

Action verb—a verb that is an action that someone performs physically or mentally 
 

We wrote a letter to the editor.  
We expect the letter to be printed. 

 

Transitive verb—a verb followed by a direct object that answers the question what? or whom? 
 

The spelling bee contestants studied the list of words. 
 

Intransitive verb—a verb that is not followed by a direct object 
  

My grandmother arrived early. 
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D.O. 



 

  

Linking verb—a verb that links the subject with a noun, adjective, or pronoun Linking verb—a verb that links the subject with a noun, adjective, or pronoun 
 Forms of be are often used as linking verbs.  Forms of be are often used as linking verbs. 

  

The pie tastesThe pie tastes delicious. They are extraordinary students. 
 

Helping verb—a verb that helps the main verb express an action or state of being 
Helping (or auxiliary) verbs include forms of be, do, and have.  Other helping (or auxiliary) verbs are 
can, could, may, might, must, shall, should, will, and would. 

 

We should study for our test.  (Should is the helping verb; study is the main verb.) 
 

Verb phrase—a group of words made up of at least one helping (or auxiliary) verb and a  
main verb 

 

They have finished the work. He could be bringing us the food. 
 

Verb tense—indicates the time of the action or state of being   
 The three simple tenses are present, past, and future. 

 

Present tense—indicates a current action or state of being 
  

I live in Lee’s Summit.  I am hungry. 
  

Past tense—indicates a past action or state of being 
 

I lived in an apartment.  I was thirsty. 
 

Future tense—indicates a future action or state of being 
 

I will move to Arizona soon. I will be hungry. 
 

Irregular verb—a verb that does not use –ed in the past tense or in past participle forms 
  

She drove the truck home. She had never driven a truck before. 
 

Past participle—verb form used with forms of have to indicate the past tense 
 

I have been there before. We had never eaten sushi. 
 

Progressive—verb form used with forms of be to indicate a continuous action 
 

We are looking for our car. The pencil was resting on the desk. 
 

Active voice—indicates that the subject performs the action 
 

My mother wrapped the gifts. 
 

Passive voice—indicates that the subject receives the action 
 

The gifts were wrapped by my mother. 
 

The best kind of writing, and the biggest thrill in writing, is to suddenly 
read a line from your typewriter that you didn’t know was in you. 

 

--LARRY L. KING 
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   Adjective—a word that describes or modifies a noun      
             

 

An adjective tells what kind, how many, which one(s), and whose. 
 

The tired and thirsty hikers stopped to rest.  (Tired and thirsty modify hikers.) 
 

Proper adjective—refers to an adjective formed from a proper noun 
 

The Danish prince  Thanksgiving dinner 
 

Articles—the adjectives a, an, and the 

 
             

   Adverb—a word that modifies a verb, adjective, or another adverb    
             

An adverb tells how, how much, how often, when, where, or why. 
 

today    slowly 
usually    sometimes 

 
             

   Preposition—a word/word group that connects a noun to the rest of the sentence  
             

 

to    next to 
under    in spite of 

 

Prepositional phrase—a group of words that begins with a preposition and ends with a noun or  
pronoun (the object of the preposition) 

 

under the bed   for me     

 
             

   Conjunction—a word that connects single words or groups of words    
             

 

Coordinating conjunction—a conjunction that joins words or phrases of equal rank 
 (Many grammarians use the acronym FANBOYS to remember the seven conjunctions.) 

for and nor but or yet so 
 

Oliver was cold and hungry.   
I asked for your assignment, but you didn’t turn one in. 

  

Correlative conjunctions—conjunctions that work in pairs  
(either/or, neither/nor, not only/but also, both/and ) 

 

Either Richard or Colby will be voted off the island. 
  

Subordinating conjunction—a conjunction that joins a dependent clause to an independent clause  
(before, if, since, unless, where, when, while, until, than, as, after, although, because, as if, and so that) 

 

Before I can leave, I must find my keys.  
  (dependent clause)     (independent clause) 

 
             

   Interjection—an unrelated word or phrase that communicates emotion or surprise  
             

  

Help!    Good grief.   
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Wow!    Ouch! 



 

SSEENNTTEENNCCEE  SSTTRRUUCCTTUURREE  TTEERRMMIINNOOLLOOGGYY  
 

Subject—the key noun or pronoun that tells what the sentence is about 
 

The king beheaded his enemies. (simple subject) 
Charles and I escaped execution. (compound subject) 

  

Predicate—the key verb or verb phrase that expresses what the subject is or does 
 

The king beheaded his enemies. (Beheaded is the simple predicate; beheaded his 
enemies is the complete predicate.) 

 

Direct object—the noun, noun phrase, or pronoun that receives the action of the verb 
 

I adore my English teacher. They can see it.  
 

Indirect object—the noun, noun phrase, or pronoun that indirectly receives the action of the verb  
The indirect object answers the question to whom, for whom, to what, or for what. 

 

My boss offered me a raise. My parents gave my sister their old car. 
(A raise = direct object/me = indirect)  (their old car = direct object/ sister = indirect)        

 

Appositive—a noun, noun phrase, or pronoun that adds an explanation or new information about the noun 
it follows 
 

Mark Twain, one of my favorite humorists, was born in Missouri. 
My brother George loaned me the money. 
 

Noun of address—a noun or a pronoun that names the person or thing being spoken to 
 

Jack, where is my brand new car? 
How in the world, Heather, did you get your hair like that? 

 

Gerund—a verb form with an -ing ending that functions as a noun 
 

Swimming is good exercise. 
 

Infinitive—a verb form preceded by to   
The verb in this form can often function as a noun, adjective, or adverb. 

 

My goal is to win. 
 

Participle—a verb form that functions as an adjective 
 

The kiss awakened the dreaming princess. 
The cryptographers decipher the hidden meaning in the message. 

 
         

   Clause—a group of words with a subject and predicate  
         

 

Independent (or main) clause—a clause that can stand alone 
 

Sam finished his homework.   
 

 Dependent (or subordinate) clause—a clause that cannot stand alone 
A dependent (or subordinate) clause must be attached to an independent (or main) clause. 
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Sam finished his homework after he washed all the windows. 
         (independent clause)     (dependent clause) 

 

Restrictive clause—a clause or phrase in a sentence that is needed in the sentence because it  
restricts or limits the meaning of the sentence 

 

The assistant principal who sets the testing schedule is out of the building today.  
 

Nonrestrictive clause—a clause or phrase in a sentence that is not needed to convey the basic 
meaning of the sentence (Such clauses are set off by commas.) 

 

Mr. Russell, who happens to be my neighbor, is an award-winning teacher. 
 
        

   SENTENCE TYPES ACCORDING TO PURPOSE  
        
 

Declarative sentence—a statement that tells us something about a person, place, thing, or idea 
 

Whales are mammals.  Disney World is crowded during the week of Christmas. 
 

Imperative sentence—a command (often with the understood subject you) 
 

Look at the whales.  Be prepared to discuss the story. 
 

Interrogative sentence—a sentence that asks a question 
 

Do you see the whales?  When did you read the story? 
 

Exclamatory sentence—a sentence that communicates strong emotion or surprise 
 

That’s amazing!   I love studying English grammar!  
 
        

   SENTENCE TYPES ACCORDING TO STRUCTURE  
        
 

Simple sentence—a declarative, interrogative, or imperative sentence that is not part of 
another sentence 

Whales are mammals.  Where are the whales? 
Look at the whales.    

Compound sentence—a sentence with two or more independent clauses  
The bell rang, and the students started to work. 

 

Complex sentence—a sentence with one independent clause and one or more dependent clauses 
When the teacher arrives late, the students begin class without her. 

(dependent clause)   (independent clause)   

Compound-complex sentence—a sentence with more than one independent clause and at least 
one dependent clause 

We love studying grammar; if they take away our grammar books, we’ll organize a 
protest.  

                (independent clause)                   (dependent clause)                     (independent clause) 
 

Double negatives—a sentence that uses two negative words to express one negative idea 
This usage is not accepted practice.  Negative words include no, not, never, none, no one, nobody, nowhere,  
but (as only), hardly, and scarcely. 
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Incorrect:  I don’t have no money.           Correct:  I don’t have any money. – OR – I have no money. 



 

 

Modifier—an adjective or adjective clause that describes or specifies a noun or pronoun 
A modifier can also be an adverb or adverb clause that enhances a verb, adjective, or adverb. 

  

The extremely boring lecture caused me to doze intermittently. 
              (adv.)           (adj.)            (adv.) 

  

Prefix—a word part added to the beginning of a base word 
  

unnecessary   preview   misuse 
 

Suffix—a word part added to the end of a base word 
 

announcement   likely   careful 
  
  

LLIITTEERRAARRYY  TTEERRMMSS  
 

Allegory – an extended work in which characters, events, and settings represent abstract qualities and 
in which the writer intends a second meaning to be read beneath the surface 

Alliteration – the repetition of consonant sounds at the beginning of words (as in wild and woolly) – also 
called head rhyme, initial rhyme 

Allusion – a passing reference to historical or fictional characters, places, or events, or to other works 
that the writer assumes the reader will recognize 

Analogy – a comparison of similar things, often for the purpose of using something familiar to explain 
something unfamiliar 

Antagonist – usually the character in fiction or drama who stands in direct opposition to or in conflict 
with the central character 

Archetype – a pattern or model of an action, a character type, or an image that recurs consistently 
enough in life and literature to be considered universal 

Aside- in drama, a remark spoken to the audience, which the characters do not hear 

Assonance – the close repetition of vowel sounds within words as in fade/pale 

Blank verse – poetry written in unrhymed iambic pentameter, not to be confused with free verse 

Characterization – the method by which an author creates the appearance and personality of imaginary 
persons and reveals their character   

Climax – the moment of highest intensity and interest in a drama or story 

Comic Relief- the use of humor to receive intense emotion 

Conflict – the struggle between opposing forces that determines the action in drama and stories 

 - 59 - 



 

Connotation – the associations, images, or impressions carried by a word as opposed to the word’s 
literal meaning 

Consonance – the close repetition of identical consonant sounds within words as in leave/love 

Denotation – the precise, literal meaning of a word without emotional associations or overtones 

Denouement – a general term for the final resolution of the conflicts and complications of a play 

Dialogue- the actual words that characters speak 

Diction – word choice 

Dynamic Character- character changes his outlook or perspective 

Epiphany – a moment of revelation or profound insight 

Essay – an attempt at exploring or explaining a topic or theme; nearly always written in prose 

Exposition – in drama or other fiction, the revelation to the audience of setting, character 
relationships, and plot; in nonfiction, an explanation 

Falling action – the part of a dramatic plot that follows the climax; when the conflict is resolved, all 
questions are answered, and loose ends are tied up 

Fiction – narrative writing that is the product of the author’s imagination; an invention rather than 
actual history or fact to entertain, instruct, or persuade 

Figurative language – language that contains figures of speech such as metaphor, simile, 
personification, and hyperbole that help the reader see what is happening 

Flashback – a way of presenting scenes or incidents that took place before the opening scene 

Foreshadowing – the technique of giving hints or clues that suggest or prepare for events that occur 
later in a work 

Free verse – a type of poetry that is “free” of the regular beat of meter, usually lacks rhyme, and has 
irregular line lengths 

Genre – a type of literary work such as a novel, short story, or lyric poem, each with its own set of 
characteristics 

Hyperbole – obvious, extravagant exaggeration or overstatement, not intended to be taken literally 

Iambic pentameter – a poetic line of five iambic (unstressed/stressed) feet; it is the meter of blank 
verse and the sonnet:  Shall I com pare thee to a sum mer’s day? 

Imagery – the making of “pictures in words” which appeals to the senses of taste, smell, hearing, touch, 
and sight 
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Inference – conclusions drawn from information given  

Irony – the recognition of the difference between what is and what seems to be; the use of words to 
express something other than and especially the opposite of the literal meaning 

 Dramatic – the audience or reader knows something that a character does not know 
 Situational – the opposite of what is expected to happen occurs 
 Verbal (sarcasm) – a character says the opposite of what he means 
 

Literary criticism – the practice of describing, interpreting, and evaluating literature 

Literature – writings in poetry and prose of recognized excellence, valued for their intense, personal, 
and imaginative expression of life 

Metaphor – a figure of speech in which something is imaginatively compared to or identified with 
another dissimilar thing, not using like or as 

Mood – the prevailing emotional attitude in a literary work such as regret, hopefulness, or bitterness 

Motif – a recurring image, word, phrase, action, idea, object, or situation that appears in various works 
or throughout the same work 

Narrative – a recounting of a series of actual or fictional events as found in short stories, novels, epics, 
ballads, histories, and biographies  

Narrative Hook – the part of the story where the reader becomes “hooked” 

Narrator – the teller of a story or other narrative 

Nonfiction – literature that is not fictional or imaginary 

Onomatopoeia – the use of words whose sound imitates the sound being named as in hum, buzz, boom, 
or hiss 

Oxymoron – a figure of speech in which two contradictory words or phrases are combined in a single 
expression, giving the effect of a paradox, as in wise fool or living death 

Parable – a short, simple tale from which a moral lesson is drawn 

Paradox – a statement that, while apparently self-contradictory, is nonetheless essentially true  
This sentence by Thoreau is a paradox:  “I never found the companion that was so companionable as solitude.” 

Parallelism – repetition of sentence structures, words, or phrases 

Parody – imitates or mocks another serious work 

Personification – a figure of speech in which human characteristics and sensibilities are attributed to 
animals, plants, inanimate objects, natural forces, or abstract ideas 
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Plot – the careful arrangement of events in a narrative to achieve a desired effect 



 

Poetic license – the freedom writers have to depart from normal word order, use archaic words, or 
invent new words to achieve certain effects 

Poetry – literature in its most intense, most imaginative, and most rhythmic form; usually written in 
lines instead of paragraphs and relying on imagery for meaning 

Point of View – the vantage point from which a narrative is told 

• FIRST PERSON – story is told by one of the characters; the reader is told only what this character knows and observes 

• THIRD PERSON – the narrator is not a character in the story at all 

1. THIRD PERSON LIMITED – focusing on thoughts and experiences of one character 

2. THIRD PERSON OMNISCIENT – all knowing; narrator describes and comments on all characters and actions in 
a story 

Prose – in its broadest sense, all forms of ordinary writing and speech lacking the sustained and regular 
rhythmic patterns found in poetry; it is the language of essays, short stories, and novels 

Protagonist – the principal and central character of a novel, short story, play, or other literary work 

Resolution – the final unwinding, or resolving, of the conflicts and complication in the plot of fiction or 
drama 

Rhetoric – the art of persuasion in writing or speaking 

Rhythm – the patterned flow of sound in poetry and prose, known as meter 

Rising action – the part of the plot that develops the conflicts that lead to the climax 

Satire – a kind of writing that holds up to ridicule or contempt the weaknesses and wrongdoings of 
individuals, groups, institutions, or humanity in general 

Setting – the time and place of a work of literature 

Simile – a figure of speech that uses like, as, or as if to compare two essentially different objects or 
actions 

Speaker – the voice of a poem, not necessarily that of the poet 

Static Character – a character’s outlook or perspective does not change; he or she remains the same 
throughout the story 

Style – a writer’s characteristic way of saying things 

Suspense – the quality of a short story, novel, play, or narrative poem that makes the reader or 
audience uncertain or tense about the outcome of events 

Symbol – anything that signifies or stands for something else 
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Syntax – the arrangement and relationship of words, phrases, and clauses in a sentence; especially 
important in discussing an author’s style 



 

Theme – the central or dominating idea; the message implicit in a work, usually not stated directly 

Tone – the reflection in a work of the author’s attitude toward his or her subject, characters, and 
readers:  friendly, teasing, or imperious are examples of tone 

Verisimilitude – plausibility or believability of the story 

Voice – a term to identify the sense a written work conveys to a reader about the writer’s attitude, 
personality, and character 

Willing suspension of disbelief – the circumstance in which the reader of a novel or a play temporarily 
withholds doubt about truth or actuality and willingly accepts the make-believe world invented by the 
author; coined by Samuel Taylor Coleridge 
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SSEECCTTIIOONN  66::    LLAANNGGUUAAGGEE  RREESSOOUURRCCEESS  
  

RREESSOOUURRCCEESS  WWEE  RREEAALLLLYY  LLIIKKEE  ((AAVVAAIILLAABBLLEE  IINN  TTHHEE  LLMMCC))  
 

Baron, Dennis.  Declining Grammar and Other Essays on the English Vocabulary.  Urbana, IL:   
NCTE, 1989.  

 

Baron discusses the wonderful world of language by looking at the mistaken beliefs we have about our daily language 
use.   

 

Fine, Edith H., and Judith P. Josephson.  Nitty-Gritty Grammar.  Berkeley, CA:  Ten Speed  
Press, 1998. 
 

With appealing cartoons and a focus on common errors and how to avoid them, this text presents a not-so-serious 
guide to clear communication. 

 

Guide to Grammar and Writing.  2004.  Capital Community College Foundation. <http://webster.  
commnet.edu/grammar>. 

 

A great on-line resource for both students and teachers, this site covers everything from grammar to writing to 
interactive quizzes. 

 

Lunsford, Andrea, and Robert Connors.  The New St. Martin’s Handbook.  Boston:  Bedford/St.  
Martins, 1999. 

 

The quintessential grammar/usage handbook, this handbook contains a section on documentation styles as well. 
 

O’Conner, Patricia T.  Woe Is I.  New York:  Riverhead Books, 1996. 
 

O’Conner offers a down-to-earth course for anyone who wants to speak and write more clearly in ten easy lessons. 
 

Strunk, Jr., William, and E.B. White.  The Elements of Style.  New York:  Macmillan Publishing  
Co., Inc., 1979. 

 

A little book that cuts the hugeness of English rhetoric down to size. 
 

Truss, Lynne.  Eats, Shoots, and Leaves: The Zero Tolerance Approach to Punctuation.  UK:  
Profile Books, Ltd., 2003. 

 

A best-seller from England for those of us who wish that punctuation weren’t a dying art. 
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